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Chapter 1 | Welcome to Aurora HDR 2019

Welcome to Aurora HDR 2019 
Aurora HDR is a joint project between Skylum and Trey Ratcliff to produce the most powerful, 
simple and fast HDR photo editing software in the world for Mac and PC. 

• Skylum is one of the world’s leading developers of consumer and professional photography 
software, serving Mac, Windows, and enterprise customers worldwide.  

• Trey Ratcliff is the world’s most renowned HDR photographer, with over 16 million online 
followers and more than 150 billion views of his images. Besides fine art sales to collectors 
around the world, he runs the #1 Travel Photography blog at www.stuckincustoms.com.  

When Skylum looked to create the best HDR software ever, we turned to Trey to assist at all stages. 
Using Trey’s vast experience with the current tools in the market, and advanced technology from 
Skylum, we have jointly created state-of-the-art software to help photographers of all skill levels 
create amazing high-dynamic-range photos. 

Aurora HDR 2019 contains every imaginable tool needed to produce high-quality “next generation” 
dramatic images, as well as Aurora HDR Looks and video training developed by Trey and other 
professional photographers that will appeal to every photographer. 
__________________________________________________ 

What is HDR? 
High Dynamic Range (HDR) photography is a popular photographic technique designed to 
overcome the limitations of image sensors in digital photographs. This process utilizes multiple 
exposures of the same subject, each shot at different exposure values (“brackets”). Those brackets 
are then automatically merged into a single shot which encompasses a greater exposure range. 
__________________________________________________ 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Chapter 2 | Key Features and Benefits of Aurora HDR 2019

Key Features and Benefits of Aurora HDR 2019 
•  Tone-mapping technology for single and bracketed images with the Quantum HDR Engine  

•  HDR Smart Structure for realistic and artifact-free depth and details  

•  LUT Mapping filter for creative color and tone adjustments  

• Total HDR editing experience with the most complete set of tools available 

• Powerful one-click Aurora HDR Looks, including Signature Pro Looks by Trey Ratcliff, Serge 
Ramelli, Randy Van Duinen, and others, that yield fantastic results instantly 

• Layers, brushes and masking provide the ultimate in selective editing. 

• Luminosity masking to blend layers 

• Unique Radiance and Glow controls and custom texture blending for creative versatility 

• Detail enhancement to increase drama in images 

• Extensive color and toning controls for vibrant color combinations 

• Batch processing that auto-detects brackets 

• Modern user interface design makes for a comfortable, understandable experience 

• Built-in sharing supports popular photo communities and social networks 

• RAW, JPG, TIFF and other popular filetype support for the greatest flexibility 

• Workflow tailored to any style with support for using as a standalone app or as a plugin to 
popular host applications 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Chapter 3 | Key New & Improved Features of Aurora HDR 2019

Key New & Improved Features of Aurora HDR 2019 
There are several new features as well as improvements in Aurora HDR 2019 to help you create 
fantastic images in less time. 

User Interface / Performance 
• NEW: Tone-mapping technology for bracketed images with the Quantum HDR Engine 
• NEW: Tone-mapping technology for single images with the Quantum HDR Engine 

Editing 
• NEW: HDR Smart Structure for realistic and artifact-free structure 
• NEW: All new Aurora HDR Looks to enhance and stylize images 
• NEW: LUT Mapping filter for creative color and tone adjustments 
• NEW: Eleven integrated  LUTs to use with the LUT Mapping filter 
• IMPROVED: HDR Details Boost filter that allows for high-resolution tuning while adjusting 
• IMPROVED: Adjustable Gradient filter with new controls for Shadows and Highlights 

Open / Plugin / Export 
• NEW: Photoshop plugins support 
• NEW: Photolemur plugin support 
• NEW: Plugins menu for both Mac®  and Windows®  users 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Chapter 4 | Installing and Activating Aurora HDR 2019

Installing and Activating Aurora HDR 2019 
There are a few ways to install Aurora HDR on your computer. The method you choose will depend 
upon how you purchased Aurora HDR. 

If Bought Directly from Skylum 
If you purchased the software from our website, you’ll need to download and install your software.  
Follow these steps. 

Install for Mac 
1. Click the download link in your activation email (sent after purchase). 
2. Locate the installer in your Downloads folder. 
3. Double-click Aurora_HDR_2019.dmg to open the installer. 

4. Drag the application into your Applications folder. 
5. Choose Go > Applications to navigate to your Applications folder. 
6. Locate the Aurora HDR 2019 application and double-click to launch. 
7. Enter the email address you used while purchasing the software and your activation key 

(from your activation email) to complete installation and registration. 
8. Click Activate to launch the application.  

If you ever lose your activation key, provide our support team with your email address and they can 
restore the activation code for you. You can also look up your products and keys at https://
skylum.com/support. 
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Chapter 4 | Installing and Activating Aurora HDR 2019

Install for PC 
1. Click the download link in your activation email (sent after purchase). 
2. Locate the installer in your Downloads folder. You may need to unzip the installer before 

running it. 
3. Double-click Aurora_Win_Setup.exe to launch the installer application and begin the 

installation process. 
4. Choose an installation location or use the default path. 

5. Click Install to start the installer. You may need to grant the installer permission to proceed. 
6. When the installer is complete, leave the checkbox marked for Run Aurora HDR 2019 and 

click Finish. 
7. Review and agree to the License Agreement. 
8. Enter the email address you used while purchasing the software and your activation key to 

complete installation and registration. The application is now ready to use. 
If you ever lose your activation key, provide our support team with your email address and they can 
restore the activation code for you. You can also look up your products and keys at https://
skylum.com/support. 
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Chapter 4 | Installing and Activating Aurora HDR 2019

If Bought from the Mac App Store 
Mac users may also choose to purchase Aurora HDR 2019 from the Mac App store.  If you have 
done so, please follow these steps. 

1. Launch the Mac App Store. 
2. In the Search field type Aurora HDR. 

3. Locate Aurora HDR 2019 and click the BUY APP button. 
4. The Mac App Store may ask you to verify your Apple ID and password. 
5. Aurora HDR is downloaded to your Applications folder. 
6. In the Finder, choose Go > Applications (Shift+Command+A) and locate the Aurora HDR 

application. 
7. Double-click the Aurora HDR 2019 app to launch and use the application. 

If you ever delete the Aurora HDR 2019 application from your computer, you can re-download it 
from the Mac App Store. 
__________________________________________________ 

NOTE 
The Mac App Store version of Aurora HDR 2019 doesn’t offer the ability to be used as a plugin. To 
get a version that can, please contact support@skylum.com.  Just provide proof of purchase and they 
will give you a version that can be used as a plugin. 
__________________________________________________ 
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Chapter 5 | System Requirements for Mac OS and Windows®

System Requirements for Mac OS and Windows®  
Aurora HDR 2019 Mac  

• MacBook® , MacBook Air® , MacBook 
Pro® , iMac® , iMac Pro® , Mac Pro® , Mac 
mini®  

• Processor Intel®  64-bit Core™  2 Duo or 
better 

• Memory 8 GB RAM or more 
• macOS®  High Sierra 10.13,  

Sierra 10.12.6, El Capitan 10.11.5, 
Yosemite 10.10.5 

• Hard disk 2 GB free space, SSD for best 
performance 

• Display 1280x768 resolution or better 
• You can check your system 

specifications and hardware by 
choosing  > About this Mac 

Aurora HDR 2019 Windows 
• Windows®-based PC with mouse or 

similar input device 
• Open GL 3.3 or later compatible 

Graphics Cards 
• Processor Intel®  Core™  i5 or better 
• Memory 8 GB RAM or more 
• Microsoft Windows®  7, Windows®  8.1, 

Windows®  10 (only x64-bit OS) 
• Hard disk 2 GB free space, SSD for best 

performance 
• Display 1280x768 resolution or better 
• You can check your system 

specifications by opening Settings and 
clicking About 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Chapter 6 | Installing Aurora HDR 2019 as a Plugin

Installing Aurora HDR 2019 as a Plugin 
While Aurora HDR is a full featured stand-alone application, some users also choose to install and 
run it as a plugin for other popular photo editing software. Whether you download it from the Mac 
App Store or choose to install it as a plugin at a later time, you can easily do so. 

1. Make sure Aurora HDR is open. 
2. On a Mac, simply choose Aurora HDR 2019 > Install Plugins… On a PC choose File > 

Install Plugins…. 
3. A new dialog box appears to show you which supported host applications are currently 

installed on your computer.  

The host applications supported by Aurora HDR 2019 are: 
• Adobe Photoshop®  
• Adobe Photoshop Lightroom®  Classic CC  
• Adobe Photoshop Elements®  (Mac-only) 
• Apple Aperture®  (Mac-only) 

4. Click the Install/Uninstall button for the apps in which you’d like Aurora HDR 2019 to run. 
5. When finished, click Done to close the installer window. 

__________________________________________________ 

TIP 
For Mac-users, (though it’s not listed in the plugin dialog box), Aurora HDR can operate as an editing 
extension in Photos for Mac. This will allow you to use it on your computer as an additional editor 
within the Photos for Mac application. 
__________________________________________________ 

NOTE 
For best results, quit the host application, (such as Photoshop) before you install the plugin. You may 
be prompted to enter your Administrator password to complete the installation. 
__________________________________________________ 
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Using Aurora HDR 2019 with Adobe Photoshop /  
Adobe Photoshop Elements 
Aurora HDR is a powerful addition to Adobe Photoshop and Photoshop Elements. To apply Aurora 
HDR as a filter, follow these steps: 

1. Make sure Adobe Photoshop or Adobe Photoshop Elements is open. 
2. Open an image you’d like to enhance. 
3. Choose Filter > Skylum Software > Aurora HDR 2019…  

4. A new dialog box appears to indicate that Aurora HDR is running. 
5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2019’s tone 

mapping features 
6. Click the Create HDR button to process the image in Aurora HDR 2019. 
7. Make any edits or adjustments as needed in Aurora HDR.  You can use Aurora HDR Looks to 

speed up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Photoshop. 

__________________________________________________ 

NOTE 

Aurora HDR 2019 can operate as a Smart Filter in Photoshop. If you designate a Photoshop layer as a 
Smart Filter, then launch the Aurora HDR 2019 plugin as normal to make edits. When you return to 
Photoshop you can always double-click on the layer and return to Aurora HDR 2019 with all edits 
intact. 

__________________________________________________ 
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Chapter 6 | Installing Aurora HDR 2019 as a Plugin

Using Aurora HDR 2019 with Adobe Lightroom Classic CC 
Images in Adobe Photoshop Lightroom Classic CC can be easily handed off for editing in Aurora 
HDR 2019. To transfer a file from Lightroom Classic CC to Aurora HDR 2019, follow these steps: 

1. Make sure Adobe Photoshop Lightroom Classic CC is open. 
2. Choose your image(s) in Lightroom Classic CC from the Develop module that you want to 

work on in Aurora HDR 2019. 
3. Choose File > Export with Preset and choose from one of two options. 

• Open Source Files. This option sends a 16-bit TIFF file from Lightroom to Aurora HDR 
2019 and removes any adjustments that were applied in Lightroom first. 

• Edit a Copy with Lightroom adjustments. This option sends a 16-bit TIFF file from 
Lightroom to Aurora HDR 2019 and includes any adjustments that were made in 
Lightroom to the transferred file. 

4. A new dialog box appears to indicate that Aurora HDR 2019 is running. 

5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2019’s tone 
mapping features 

6. Click the Create HDR button to process the image in Aurora HDR 2019. 
7. Make any edits or adjustments as needed in Aurora HDR 2019.  You can use Aurora HDR 

Looks to speed up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Lightroom. A new 

file is added to your Library and stacked with the original. 
__________________________________________________ 

NOTE 

If you want to apply Aurora HDR to a single image, you can also access it from the Photo > Edit In > 
Aurora HDR 2019… menu item.  The processed image will be returned to your library. 

__________________________________________________ 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Chapter 6 | Installing Aurora HDR 2019 as a Plugin

Using Aurora HDR 2019 with Apple Aperture 
Working with Aurora HDR 2019 through Aperture is very similar to the way it interacts with 
Lightroom. To transfer a file from Aperture to Aurora HDR 2019, follow these steps: 

1. Make sure Apple Aperture is open. 
2. Choose your image(s) in Aperture from the Library that you want to work on with Aurora 

HDR 2019. 
3. Choose Photos > Edit with Plug-in > Aurora HDR 2019… or right-click the Image and 

select Edit with Plug-in > Aurora HDR 2019.… 
4. A new dialog box appears to indicate that Aurora HDR 2019 is running. 

5. Check the Tone Mapping box if you want to take advantage of Aurora HDR 2019’s tone 
mapping features. 

6. Click the Create HDR button to process the image in Aurora HDR 2019. 
7. Make any edits or adjustments as needed in Aurora HDR 2019.  You can use Aurora HDR 

Looks to speed up your editing workflow. 
8. When done, click the Apply button to send the adjusted image back to Aperture. A new file 

is added to your Library and stacked with the original. 
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Chapter 6 | Installing Aurora HDR 2019 as a Plugin

Using Aurora HDR 2019 as a Photos for Mac Extension 

If the version of the macOS®  system on your Mac is newer than 10.11, you can use Aurora HDR 

2019 as an extension to Photos for Mac® . Here’s how to activate the extension. 

1. Choose  > System Preferences. 
2. Choose Extensions. 
3. Choose Photos Editing. 

4. Select the extensions that you'd like to use.  
5. Launch Photos for Mac from your Applications folder. 
6. Choose an image to edit in your Photos library. 
7. Click the Edit Photo button. 
8. Click the Extensions button and choose Aurora HDR 2019. 
9. Make any edits or adjustments as needed in Aurora HDR 2019.  Use Aurora HDR Looks to 

speed up your editing workflow. 
10. When done, click the Save Changes button to send the adjusted image back to Photos  

for Mac. 
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Chapter 7 | Starting with Aurora HDR 2019

Starting with Aurora HDR 2019 
Aurora HDR 2019 offers many easy-to use as well as powerful controls to adjust and improve your 
image.  The first step of course is opening one or more images within the application.  
Aurora HDR 2019 can open a series of the same images shot with different exposures. A series of 
images with different exposures are commonly known as HDR brackets. Aurora HDR 2019 supports 
any practical number of images in a bracket. In addition, all versions can open just a single image 
which is great for enhancing the dynamic range in your photo (especially for raw photos). 

How to Open a Single Photo 
There are several ways to open images based on your personal preference.  Each of these four 
methods generates the same outcome, so choose the one that works best for you. 

1. First, launch Aurora HDR 2019. 
2. You can now open a supported file format using any of these methods: 

• At the startup screen, click the Open Image button to navigate to and open a file. 
• Choose File > Open… to navigate to and open a file. 
• To open an image you recently edited, choose File > Open Recent. 
• You can also drag a photo directly onto the Aurora HDR 2019 application in the Mac OS 

Dock or Windows Taskbar. 
3. A preview of your photo opens in a new dialog box where you may want to make a few 

selections. 

4. Click the Settings icon (gear) to choose from two options that can affect the opened file. 
• Color Denoise Turn this option on to remove lowlight color noise when merging brackets.  

This option is visible only when opening a raw file.  It will also increase the processing time 
for the image due to the noise removal process. 
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Chapter 7 | Starting with Aurora HDR 2019
• Chromatic Aberration Removal Use this option to remove the purple or green fringe 

that can appear along the edges of an image (especially in areas of high contrast or 
backlight). 

5. Click Create HDR to open the file and begin editing. 

Supported File Types 
Aurora HDR 2019 is designed to open a wide range of file formats.  This ensures compatibility with 
most cameras as well as common graphic file formats.  Supported file types include: 

GRAPHIC FORMATS 

• PNG 

• JPEG 

• JPEG-2000 

• TIFF (8-bit and 16-bit) 

• PSD 

• HEIC (Mac-only) 

POPULAR RAW FORMATS 

• .CR2 

• .NEF 

• .ORF 

• .RAF 

• .ERF 

• .ARW 

• .RW2 

• .DNG 

• .PEF 

• and more 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The Purpose of 
Bracketed Photos 
In order to capture all the details 
in a scene, many photographers 
turn to bracketing.  When using 
the bracketing option on a 
camera, (or manually adjusting 
exposure), the photographer will 
capture two or more shots.  
The most common number of 
exposures taken is three, in 
which a base exposure is used 
and then an under- and 
overexposed image are 
acquired to preserve the highlights and shadows. However, any combination of exposures can be 
used to properly portray the scene. The wider the dynamic range of the scene, the higher the 
number of exposures needed. If the light source is directly in the frame, you may need as many as 
seven exposures. 
Typically, these multiple exposures are taken from a tripod to ensure that there is no movement 
between each exposure.  However, some users do shoot handheld and rely upon the Alignment 
option in Aurora HDR 2019 to help them align the images. When you select multiple images in a 
bracketed set, you will see a preview window with the images you plan to process as well as 
additional details about those images. 

The image on the left was captured two stops over-exposed (EV +2.0)  to preserve details in the 
darker areas of the image.  The middle photo is the base exposure as calculated by the camera.  The 
image on the right was captured two stops under-exposed (EV -2.0) to preserve details in the 
brighter areas of the image. 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Creating the Merged HDR Image 
When you have a series of bracketed photos, you can choose to merge them together for a photo 
with significantly more dynamic range.  The Open dialog box allows you to open your own images, 
(and also includes a set of sample photos).  You can also choose to open a folder of images for 
Batch Processing. (More on this later.) 

1. First, launch Aurora HDR 2019. 
2. You can now open a supported file format using any of these methods. 

• At the startup screen, click the Open Image button. 
• Choose File > Open… to navigate to multiple files, select them, and open them. 
• You can also drag a series of photos directly onto the Aurora HDR 2019 application in the 

Mac OS Dock or Windows Taskbar. 
3. Your photos open in a new window where you’ll need to make a few selections. 
4. Click the Settings icon (gear) to choose from three options that affect the opened file. 

• Ghost Reduction Ghosting is caused by subject movement, (such as clouds blowing, 
trees swaying, or people moving). If there is a long time delay between your brackets, you 
may notice areas of high movement appear to have multiple copies of image details that 
overlap.  This option can remove these repeated details from your final photo. 

• Color Denoise Turn this option on to remove lowlight color noise when merging brackets.  
This option is only visible if opening a raw file.  It will also increase the processing time for 
the image due to the noise removal process. 

• Chromatic Aberration Removal Use this option to remove purple or green fringe that 
can appear along the edges of an image (especially in areas of high contrast or backlight). 

5. Use the Auto Alignment option if shooting handheld or if you think that there might be 
slight camera movement between each shot. 

6. When ready, click Create HDR to merge the brackets together. 
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Ghost Reduction 
If there are moving objects in your HDR brackets — tree leaves, flags, people, etc. — the resulting 
image can look a bit unusual after the HDR merge process. The moving object may appear as a 
translucent “ghost.” This is simply because the image information is different in each HDR bracket 
image, (i.e., something has moved through the frame of the photo).  

The image on the left was merged without the Ghost Reduction option.  In areas of high-movement, (such as 
the nets blowing in the wind), parts of the photo look unusual.  Ghost Reduction will increase processing time 
but should be considered for photos with lots of wind or long delays between brackets such as low-light 
shooting. 

To minimize this problem, click the Additional Settings button which will reveal a pop-over panel 
for enabling Ghost Reduction. This feature will let you choose a reference image from the bracket. 
The software will then analyze each of the exposures and compare it to the reference image before 
merging them into a single HDR image. The result is that any object that changed positions 
between exposures will be replaced with a static object whose position is selected from one of the 
images in the bracket.  

Aurora HDR 2019 User Guide Page !  of !18 103

Im
ag

e 
by

 R
ic

ha
rd

 H
ar

rin
gt

on



Color Denoise 
This feature reduces low-light noise found in color or “chrominance” pixels during the merging 
process for RAW files. Access this by clicking on the Additional Settings button which will reveal a 
pop-over panel for enabling Color Denoise. There are no additional controls provided when using 
this option. This option will increase the processing time of your image. 

Chromatic Aberration Removal 
This feature analyzes the merged HDR image and minimizes any chromatic aberrations which have 
been detected. These are typically characterized by a slight red or purplish glow along the edges of 
stark contrasting areas in the image. These optical aberrations, however slight, are always present 
on any photo and may reduce picture quality. If you think that your image may include red or 
purple halos, click the Additional Settings button which will reveal a pop-over panel for enabling 
Chromatic Aberrations Reduction. This option will increase the processing time of your image. 

Auto Alignment 
If the photos in an HDR 
bracket set were taken by 
hand (e.g., without a 
tripod), they may differ 
slightly in alignment. If the 
Alignment option is 
checked, the application 
automatically aligns all the 
images before merging 
them into a single HDR 
image. Aurora HDR 2019 
makes it easy to use images 
from an HDR bracket series, 
even those shot without a 
tripod.  
If you open an image from an HDR bracket without Alignment, and it is slightly blurred, simply open 
it again with the Auto Alignment option enabled. 
__________________________________________________ 

ATTENTION! 
Each of these three options can slow down the creation of your HDR image because they require 
significant computing resources to analyze the images. In the case of Ghost Reduction, it is also 
worth noting that this feature may not always work as expected while attempting to obtain a single 
static image from a series of moving images. Keep this option off and use it only when you need to 
fix apparent problems with ghosting. 
__________________________________________________ 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Chapter 8 | User Interface Overview

User Interface Overview 
Working with Aurora HDR 2019, you’ll access controls from three primary areas.  The Top Toolbar 
contains general-purpose and frequently used functions of the software.  The Side Panel is located 
to the right of the main image display; all adjustment tools, layers and the histogram can be found 
here. You can also save time with the Aurora HDR Looks Panel which offers one-click Aurora HDR 
Looks at the bottom of the screen. 

Top Toolbar  
As you work with an image, the top toolbar contains many commands that you’ll frequently use.  
These are grouped logically for easier use. 

Open Images / Batch Processing Button 
The first button is a drop-down menu that controls how files are opened.  You can choose to open 
files to process one image or bracket set, or choose the Batch option to process multiple images 
using similar settings.  The batch feature is currently a Mac-only feature but is coming to 
Windows®  soon. Click and hold down the button to choose between two options. 

• Open – This choice is used to load new images for processing. The shortcut keys are 
Cmd+O (Mac) or Ctrl+O (PC). 

• Batch Processing – The second option opens up the Batch Processing dialog box. This is a 
way to process multiple images at one time. The shortcut is Cmd+B (Mac) or Ctrl+B (PC). 
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Chapter 8 | User Interface Overview

Zoom Buttons 
These next three buttons are used for changing your view of the image size in the canvas. If you 
view from left to right, the buttons are the following. 

• Zoom Level – Choose from several preset zoom levels or select Fit to Screen to see the 
entire image at once. 

• Zoom Out –  This option reduces the  view size of the displayed image. The shortcut keys are 
Cmd+- (minus) (Mac) or Ctrl+- (minus) (PC). You can see the current zoom level at the 
bottom of the canvas. 

• Zoom In – This option increases the  view size of the displayed image. The shortcut keys are 
Cmd+= (equals sign).  (Mac) or Ctrl+= (equals sign) (PC). 

__________________________________________________ 
TIP 
You can also use keyboard shortcuts to control  the display of an image on-screen.  To view an image 
at its original size, press Cmd+1 (Mac) or Ctrl+1 (PC).  This sets the image to a 100% magnification 
showing the pixels in actual size.  To see the entire image in the canvas at once, try the Fit to Screen 
command.  Press Cmd+0 (Mac) or Ctrl+0 (PC) to automatically scale a photo to fit the canvas. 
__________________________________________________ 

Comparison Buttons 
These buttons allow you to compare your enhanced image with the original default image, so you 
can easily compare how your enhancements change the original image.  
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• Quick Preview – The eyeball icon can quickly toggle between the original image and the 
current version.  Another way to see this change is to use the keyboard shortcut \ 
(backslash).  This allows you to quickly compare the current image with the original. This is 
the fastest and most convenient mode of comparison. 

• Compare Button – This button activates a comparison where the image is divided by a 
vertical strip or “curtain”. The original image (Before) is displayed on the left, and the current 
result (After) is on the right. This vertical strip can be dragged left or right, so you can view 
the differences in the picture. Another way to see this view is to use the keyboard shortcut ; 
(semicolon).   

Undo / History Buttons  
The next two buttons control the Undo command as well as let you view an image’s history.  These 
two buttons give you complete control over reverting to an earlier state of an image. 

• Undo – The Undo Button (left arrow) cancels the last action (for example, changing the 
slider). You can hold down the Option/Alt key and click the Undo button to revert an image 
to its original state. 

• History Panel – The History panel will quickly become 
an essential part of your workflow. It’s here that 
Aurora HDR 2019 keeps a list of what you have done 
to the image since you opened it. There are multiple 
undos which provide an easy way to go back in time.   
 
Simply click an earlier  History State to revert the 
photo back to that state..  History states are also 
saved with an image when you store it in the native 
Aurora HDR 2019 (.mpaur2) file format.  This allows 
for a nondestructive editing workflow and let’s you 
revert to an earlier version of the image. Saving the 
history with your document preserves future editing and 
undos, but can increase the file size. 
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Crop Button 
The next button activates the crop tool.  This makes it easy to change the composition of your 
image as well as a viewer’s perception of an image. You can choose to tighten the area of interest 
which allows you to de-emphasize (or even eliminate) parts of a photo and improve the image by 
better framing the subject. An additional benefit is that the crop tool can also be used to align 
(straighten) the horizon in an image it is not horizontal. We’ll discuss cropping again in a later 
chapter. 

View Aurora HDR Looks Panel/Side Panel Buttons 
The next two buttons affect which controls are visible.  You can choose to hide options like the 
Preset Panel and Side Panel to make a larger preview image. 

• Show/Hide Aurora HDR Looks Panel – The Preset Panel on the bottom of the Aurora HDR 2019 
workspace is where you’ll find all of your Aurora HDR Looks.  These include those created by the 
Aurora HDR 2019 team as well as your own custom Aurora HDR Looks.  To hide the Preset Panel, 
just click the button to toggle visibility or press the Tab key to hide both the Side and Aurora 
HDR Looks Panels. 

• Show/Hide Side Panel – The Side Panel on the right side of the Aurora HDR 2019 workspace is 
where you’ll find the Histogram, Layers, and Filters controls.  This area is a fixed width and is 
always displayed on the right.  To hide the Side Panel, just click the button to toggle visibility or 
press the Tab key to hide both the Side and Preset Panels. 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Share/Export Button 
The last button in the top Toolbar is used to export an image from the application and save it as a 
graphic file. The same image can also be shared with other editing software from Skylum (and 
others) or uploaded directly to social networks and other online services. 

Side Panel 
The Side panel gives you access to three important sets of controls.  The Histogram is a useful tool 
for judging exposure and details. Layers lets you work with multiple objects to create a composite 
image or to isolate effects or textures to their own place.  The Filters section gives you precise 
control over each filter applied to a layer. 

Histogram /Layers / Info Buttons 
At the top of the side panel are three buttons that provide advanced controls over your images.  If 
you are just getting started with Aurora HDR 2019, you might leave these three options inactive.  
However, as you grow more comfortable with editing tasks or are looking for maximum flexibility  
and control, be sure to explore them. 
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HISTOGRAM 
While color correcting or adjusting exposure, the histogram can be a great help. A histogram is a 
graphical representation of the tonal values of your image. This graph illustrates how the pixels in 
the image are distributed across brightness levels. In other words, it shows the amount of tones of a 
particular brightness found in your photograph, ranging from black (0% brightness) to white (100% 
brightness). Ideally, well balanced images will have tonal values across the entire range of the 
histogram. 

To read a histogram, start at the left edge, which shows the shadow regions. The middle shows the 
midtones (where most adjustments to an image are made), and to the right are the highlights.   
The histogram is able to displays Red, Green and Blue channels separately or by default shows all 
of them at once.  Click on the Histogram to switch between seeing a composite Histogram or just 
viewing details about the Red, Green, and Blue channels (which can be useful for spotting tint 
issues and color casts). You can also see a grayscale average for luminance. 

Additionally, clicking the two small triangles in the upper left  and upper right corners will show 
cold and hot pixels respectively.  These are pixels that have shifted or exposed to become 
absolutely black or white pixels.  This is generally undesirable as it causes a loss of detail. 

Aurora HDR 2019 User Guide Page !  of !25 103



Chapter 8 | User Interface Overview
• Cold Pixels – To enable or disable the display mode of absolutely black pixels, click the 

triangle on the left and the histogram is clipped on the left side. Absolutely black pixels will 
be displayed in bright blue in the image.  Cold pixels (in blue) indicate areas where black 
has achieved maximum concentration (a zero value). 

• Hot Pixels –  Clicking the triangle on the upper right will show where your image is 
completely white, where the histogram is clipped on the right side. Absolutely white pixels 
are displayed in red. 

In both cases this can be problematic (especially for printing) as there is too much ink coverage for 
cold pixels and no details at all in the hot pixels.  These indicators are a sign that you should adjust 
the exposure of the image. You may want to leave the Histogram panel open as you work, because 
it is an easy way to learn to read the graphical details of a digital image. 
__________________________________________________ 

NOTE 
The use of the HDR Basic filter is an excellent way to take control of the Black and White points as 
well as the Shadows and Highlights of an image.  We’ll explore filters more in later chapters. Pressing 
the J key will also toggle the clipping indicators On or Off if you want to see the pixels underneath. 

__________________________________________________ 

LAYERS 
Layers are a powerful way to “build up” your images with different enhancements and use of 
blending modes and masks on each layer. Using layers, you can apply corrections or enhancements 
on different layers and experiment until you achieve exactly the look you’d like for your image. 

• To create a new layer, click the + button in 
the Layers Toolbar header.  A small pop-up 
menu will appear giving you the option of 
creating a layer using one of three options.  

• Use an Adjustment Layer to create a 
layer to which you can apply a Look or any 
other adjustment in the Filters panel.  

• The Add New Image option will show a 
standard Open File dialog, allowing you 
to create a new layer with a texture file or another image that you’ve chosen. 

• Use the Add New Original Image option to place a copy of the merged HDR image onto 
the layer.  This can be useful for masking in areas or blending two copies of an image 
together. 

• To remove the layer, select the layer and click — in the Layers Toolbar. 
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• To change the blending mode of the layer, set the Layer Blending mode in the drop-down 

list, (under the word Layers) or in the fly-out menu indicated by the Gear icon (underneath 
the + icon). You cannot set the blending mode for the first layer because it is not mixed with 
anything - it is the baseline image. See more on blending modes in the chapter “Working 
with Layers.” 

• Layer Transparency Setting Click the drop-down menu with percentages near the word 
Opacity. Drag the slider to customize the opacity for the selected layer.  Opacity controls 
how opaque a layer is (and is the opposite of transparency). 

• Access Advanced Settings and Functions of a Layer. Click on the Gear icon (below the + 
icon). A context menu appears with additional features to apply to the layer. 

• Change the Order of Layers. All layers (except the first) are movable. Click and drag a layer 
to move it to a new location.  Changing the stacking order of layers can affect the order of 
operations, (how images are developed) which can change its appearance. 

• Show / Hide the Layer. Click the Visibility (eyeball) icon on the left side of a layer to toggle 
it between visible and hidden. 

You’ll learn more about layers in the chapter “Working with Layers.” 

INFO 
The Info Bar provides basic information about the file and can help you better understand your HDR 
image, as well as the zoom percentage. This information is divided into several sections and 
displays the following information (from left to right): 

• Resolution The current resolution of the image in pixels. 

• Bit Depth Aurora HDR 2019 operates in 32-bit per pixel mode to provide the highest image 
quality when working with bracketed sets. Single images are opened in 16-bit mode. 

• Exposure Value The indicator of the current HDR dynamic range. This indicator shows the 
exposure value (“EV”) of the darkest bracket, then the EV of the middle bracket and finally 
the EV of the brightest bracket, each separated by an ellipses. 

• Bracket Count The number of images used for the assembly of the HDR. 

• ISO The ISO setting used for the images when captured. 

• Focal Length The focal length of the lens used when shooting. 

• Aperture The ƒ-stop used on the lens when the images were captured by the camera. 
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Transform & Lens Correction 
Aurora HDR 2019 offers powerful 
corrections to adjust the shape of your 
photo. There are many reasons why an 
image can show distortion including 
the type of lens used and the position of the camera versus the subject.  Compensating for these 
issues makes it easier to quickly straighten images and remove distractions caused by perspective 
issues or camera position. 

• Transform Tool You can easily scale, rotate and shift your image to better fit your vision.  This 
gives you full control over the position of your photo or any texture layer. 

• Lens Correction Tool The Lens Correction tool easily fixes all kinds of lens distortion, from 
barrel and pincushion to chromatic aberration and vignetting.  This can help compensate or 
totally remove the visual artifacts caused by your lens. 

You’ll learn more about the Transform and Lens Correction adjustments in the chapter “Crop & 
Transform a Photo.” 

Filters 
Filters are how you can adjust the exposure, color, contrast, and style of your image in Aurora HDR 
2019.  The proper use of filters can significantly improve your image.  Each filter is designed to 
solve specific problems or enhance an image in a particular way. The Filters section of the Side 
panel contains 15 control groups which allow you to achieve the best possible image results. Each 
of the groups contain sliders and controls related to the filter. 
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Aurora HDR 2019 contains the following filters: 
• HDR Basic — General settings related to the Tone Mapping and compression of the image 

for the original image layer 
• Color — Color settings such as saturation, temperature and tint 
• HDR Enhance — Adjusts the clarity, structure and micro-contrast of the image, leading to a 

more “crisp” result 
• HDR Denoise — Reduces noise and artifacts in the image created by the HDR image merge 

process, as well as making the overall image smoother 
• LUT Mapping — A Lookup Table (LUT) allows you to apply preset color recipes to 

aesthetically adjust your image or to apply technical color calibration. 
• Image Radiance — Provides for an overall “dreamy” look to your image by softening image 

luminescence, and increasing contrast & saturation 
• Polarizing Filter — Provides more color depth and cuts atmospheric haze, resulting in richer, 

bluer skies 
• HDR Detail Boost — Increases image detail globally or in highlights and shadows. 
• Glow — Provides a glow effect to the image, primarily in highlights 
• Adjustable Gradient — Permits separate adjustments of exposure, shadows, highlights, 

contrast and vibrance in the upper and lower areas of the image. 
• Tone Curve — Represents the tonal range of the image along a diagonal line which can be 

adjusted by clicking and dragging May be adjusted globally or by RGB channels 
• HSL — Adjusts the hue, saturation and luminance of a particular color channel 
• Color Toning — Shadows and highlights color tinting for stylized visual effects. 
• Dodge & Burn — Selectively lighten or darken areas of your image with brush strokes. 
• Vignette — Provides a vignette effect for finishing images to a professional level 

You’ll learn more about each filter in the chapter “Using Filters.” 

Aurora HDR Looks Panel 
The Aurora HDR Looks panel contains all of the one-click Aurora HDR Looks available in Aurora 
HDR 2019. These Aurora HDR Looks can be applied to any open image or to a new Adjustment 
layer.  To apply a Look, simply click on its thumbnail.  To adjust the intensity of an effect, use the 
Amount slider to lower the Opacity of the adjustment. We’ll explore Aurora HDR Looks in depth in 
the next chapter. 

Aurora HDR 2019 User Guide Page !  of !29 103



Chapter 9 | Working with Aurora HDR Looks

Working with Aurora HDR Looks 
Aurora HDR Looks allow you to make instant changes to your HDR image with one click of a button. 
Each Aurora HDR Look is made up of all the saved filters as well as the settings used for each of 
those filters. A different Aurora HDR Look can be applied to each layer, which can make for some 
creative results! 

Applying an Aurora HDR Look 
In order to save time when developing your image, you’ll find an extensive collection of Aurora HDR                                 
Looks. Professional photographers from around the world have helped us to create a 
comprehensive group of Aurora HDR Looks that give your images amazing enhancements in a 
single click. 
To apply an Aurora HDR Look: 

1. Make sure an image is open in Aurora HDR 2019. 
2. If the Aurora HDR Looks Panel isn’t 

visible, click its button in the top toolbar.   
The Aurora HDR Looks Panel will open 
at the bottom edge of the screen. You 
can click the Aurora HDR Looks Panel 
button in the top toolbar to toggle 
between displaying and hiding the 
filmstrip bar at the bottom of the 
window. 

3. Examine the Aurora HDR Looks available by exploring their thumbnails at the bottom of the 
page.  Each offers a live preview of what the image would look like with the Preset applied. 

4. Click on an. Aurora HDR Look thumbnail to apply it. All the settings of the current Aurora 
HDR Look are immediately applied to the image. A gold frame highlights the current Aurora 
HDR Look. 

5. You can quickly switch Aurora HDR Looks by clicking on a new thumbnail. To view all the 
Aurora HDR Looks in a given category, simply use the arrow keys on your keyboard or the 
horizontal scrollbar located at the bottom of the 
Aurora 2019 window. 

6. If you hover your mouse over an. Aurora HDR 
Look, an Amount slider is revealed with the 
default set at 100% opacity. By dragging the 
Amount slider located within the Aurora HDR 
Look name, you can lower the intensity of the 
effect on your image. 

7. Click the Star icon on a Look thumbnail to add it 
to your Favorites list for easy access. 
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__________________________________________________ 

TIP 
If you want to apply an Aurora HDR Look to a new adjustment layer, click the New Overlay Look 
button in the upper-right corner of the. Aurora HDR Looks panel.  This applies the Aurora HDR Look 
to a new adjustment layer.  This makes it easy to mask the layer, adjust its opacity, or change 
blending modes.  This is a useful way to use one Aurora HDR Look on part of the image, (such as the 
sky) and another on the rest, (such as the ground).  Be sure to read more about masking  and 
blending modes for greater control. 

__________________________________________________ 

Aurora HDR 2019 User Guide Page !  of !31 103



Chapter 9 | Working with Aurora HDR Looks

Loading Additional Aurora HDR Looks 
There are many  Aurora HDR Looks included with Aurora HDR 2019.  To make it easy to manage 
these Aurora HDR Looks, you’ll find that they are organized into several groups and categories. 

Choosing a Group 
Looks are organized into three major groups. To view these options, click the Categories menu at 
the top edge of the Looks Panel.  You’ll now see several groups (as well as categories) to choose 
from, including: 

• All Aurora HDR Looks shows you both  Aurora HDR Looks created by the Skylum team as 
well as any that you’ve saved or imported. These are listed in alphabetical order. 

• Favorite Aurora HDR Looks are the  
Aurora HDR Looks that you tagged 
with a star. (Just click the hollow star 
on each thumbnail. Use these 
Aurora HDR Looks to create a 
consistent edit across a series of 
images or to keep a shortlist of your 
favorite adjustments. To remove an 
Aurora HDR Look from the favorite's 
list, click the star again. 
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Choosing a Category 
Presets are also organized into categories to help sort them by style.  These categories include  
Aurora HDR Looks created by Skylum and professional photographers. To view by category, click 
the Collections menu at the top of the Aurora HDR Looks panel.  You’ll now see several collections 
to choose from including: 

• Essentials — versatile, built-in  Aurora HDR Looks suitable for all kinds of images 

• Landscape — suitable for nature and landscape images 

• Architecture — suitable for architecture, cities, and urban landscapes 

• Dramatic — a set of creative Aurora HDR Looks for stylized photos 

• Artistic – a collection of creative Aurora HDR Looks to stylize your photos 

• Trey Ratcliff Looks — signature Aurora HDR Looks by Trey Ratcliff 

• Serge Ramelli Looks — signature  Aurora HDR Looks by Serge Ramelli 

• Randy Van Duinen Looks – professional  Aurora HDR Looks for architectural photography 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Customizing Aurora HDR Looks 
Remember, an. Aurora HDR Look is merely a starting point. Different photographers will desire 
different visual styles.  Plus, an Aurora HDR Look may work great on some photos, but need a little 
tweaking for others.  Once you select an Aurora HDR Look, you have the ability in the Side Panel to 
use Filters controls to modify that Aurora HDR Look to fit your specific image. 

Saving Custom Aurora HDR Looks 
As you adjust Aurora HDR Looks or build your own recipes from scratch, you may find a particular 
combination that you like.  Custom  Aurora HDR Looks can function as the jumping off point for 
your own look and style. An Aurora HDR Look can store a lot of control in an easy, one-click effect. 

1. Adjust an existing Aurora HDR Look or add your own effects to an image. 
2. Click the Save Filters as Aurora HDR Look 

button at the bottom-right of the Filters 
controls. 

3. A dialog will pop-up at the top of the 
window asking you to name your Look. 
Give it a descriptive name to help you 
remember what situations a Look is useful 
for.Click the Create New Aurora HDR 
Look button to store the  Aurora HDR 
Look. Once you've added the Look, it will 
appear in the User Aurora HDR Looks 
group. 
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Modifying Custom Looks 
There are additional features for user Looks that are not available for built-in Looks. To access the 
menu for a user Look, click the small triangle next to a Look's name while hovering over the Look’s 
thumbnail image. 

• Update with Current Settings — Overwrites or re-saves the Aurora HDR Look using the 
current state of the sliders in the Filters controls. 

• Delete — Deletes the current user Aurora HDR Look. 

• Rename — Renames the current Aurora HDR Look.  

• Show in Finder — Opens a Finder (Mac) or File Explorer (PC) window for the currently 
selected Aurora HDR Look file. This allows you to copy the Aurora HDR Look and pass it on 
to someone else. 

• Export — Saves the current Aurora HDR Look file to a location of your choice. 

Sharing a Custom Look 
Any Aurora HDR Looks you make can be shared with other users, manually backed up to a new 
location, or copied to a new computer.  You can freely export your own Aurora HDR Looks and 
import another person’s Looks into your application. 

1. To view any Custom Aurora HDR Looks simply chose File > Show Aurora HDR Looks 
Folder….  Aurora HDR 2019 Looks have the file extension .sal.   

2. Select the Aurora HDR Looks you want to share, then send them to fellow Aurora HDR 2019 
users. 

3. To copy  Aurora HDR Looks on another machine, just choose File > Show Presets Folder… 
on the other computer. 

4. Simply drag the new Aurora HDR Looks into your Aurora HDR Looks Folder. All Aurora HDR 
Looks in this folder should appear in the Custom category and the All Looks category. 

5. For best results, restart Aurora HDR 2019 to load all the new  Aurora HDR Looks. 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__________________________________________________ 

NOTE 
You can take precise control over your Custom Aurora HDR Looks with the File>Show Looks 
Folder… command. 

• To export, you can simply copy files from this folder. 
• To import, just copy the files into the new  Aurora HDR Looks folder. 
• To delete an Aurora HDR Look, you can simply delete the  Aurora HDR Look file in the folder. 

__________________________________________________ 

Adding a Custom Looks Pack 
Occasionally Skylum or other professional photographers will release a collection of  Aurora HDR          
Looks, called “Packs”.  
When you import a Custom Looks Pack, it will create a new category in the Presets category 
window, and display any associated Aurora HDR Looks therein. 
To add a Custom Looks Pack, select the menu item File > Import Aurora HDR Looks Pack. An 
Open dialog box is displayed, allowing you to choose the Aurora HDR Looks Pack you wish to add. 
An Aurora HDR Looks pack will have the extension .salpk. 
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Using Filters 
Filters are how you can adjust the exposure, color, contrast, and style of your image in Aurora HDR 
2019.  The proper use of filters can significantly improve your image.  Each filter is designed to 
solve specific problems or enhance an image in a particular way. Each major adjustment tool in 
Aurora HDR 2019 is contained within a “control group” generally consisting of a header with the 
name of the tool, along with a set of sliders or other controls related to this tool. 

An Overview Of Filters 
To help you get the most from Aurora HDR 2019’s filters, you’ll find a detailed guide below that 
explains the major features of each.  You may notice that certain Filters have parts that perform 
similarly. 
Common controls with every filter include the following: 

• Clicking on the header, (the section name) hides and reveals this section. 

• When hovering over a name, clicking the reset arrow restores all the sliders to their default 
state. To cancel this action, you can choose Edit > Undo. 

• When hovering over a name, clicking on the visibility icon, (eyeball) enables or disables the 
tool, allowing you to view the image with or without the effect of this tool. 
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HDR Basic 
This tool gives you the control to adjust the Tone Mapping process. Tone mapping or 
“compression” converts a wide dynamic range image into one with a more narrow range that can 
be displayed on a computer monitor. It’s a great place to start your HDR journey. 

• White Balance — Use the White Balance preset list to choose from a variety of looks that are 
similar to a camera’s white balance menu. 

• Temperature — Use this slider to warm or cool a shot.  This adjustment essentially adds Cyan 
or Yellow to an image to change its color temperature. 

• Tint — This adjusts the amount of Green or Magenta that is added to a shot.  It is useful for 
removing color casts from an image. 

• Exposure — Adjusts the global luminance of the image. Moving this slider to the left results 
in a darker image (reduction of exposure value). Moving this slider to the right results in a 
brighter image (increase of exposure value). 

• Contrast — Adjusts the contrast of the image. Contrast is the difference in luminance or color 
that makes one object in an image distinguishable from another. Practically speaking, 
contrast is determined by the difference in the color and brightness of an object in relation 
to other objects within the same field of view. 
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• Smart Tone — This slider adjusts the overall brightness of an image properly. When moved 

to the right, the image becomes more vivid, but it does not apply when the bright areas 
become as white, as the ordinary exposure. And when you move the slider to the left, the 
image becomes darker but there are no completely black areas. This is a very powerful and 
balanced image brightness tool. 

• Highlights — Adjusts the brightness of the brightest areas of the image. Moving the slider to 
the right cause very bright areas to become brighter, while moving the slider to the left, 
makes them darker. 

• Shadows — Adjusts the brightness level of the darkest areas of the image. Moving the slider 
to the right will cause such areas to become brighter and additional details to appear. When 
moved to the left, such areas become darker, and the number of shadowy areas in the 
image generally increases.  

• Whites — Adjusts the white point of the histogram and white tones in the image. When 
moved to the right, the brightest tones will become brighter while the histogram stretches to 
the right. Moving the slider to the left will cause white tones in the image to become darker 
and the histogram to compress to the left. 

• Blacks — Sets the black point of the histogram or black tones in the image. After moving the 
slider to the right, black tones become brighter and the histogram compresses to the right. 
Moving the slider to the left, blacks become darker and the histogram stretches to the left. 

A recommended workflow is to start with a light touch using Exposure and Contrast, then Smart 
Tone. Then proceed to setting Shadows and Highlights and finally, fine tune the contrast of the 
image using the Whites and Blacks sliders. 
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Color 
The Color section gives you complete control over colors and color saturation of the image. There 
are three useful controls that each affect the colors of your image in a different way,  Be sure to 
experiment with each. 

• Saturation — Adjust the color saturation of the image. This is a standard slider, similar to 
many other applications. Moving the slider to the right will cause the colors in the image to 
become more saturated, while moving the slider to the left will cause the picture to become 
black and white. 

• Vibrance — This slider is a "Smart Saturation” control. In general, its effect is similar to 
Saturation with the difference that it increases less vibrant colors stronger and has a weaker 
effect on more vibrant colors. This allows you to obtain more realistic and less saturated 
colors in your picture. This slider can be used in conjunction with the Saturation slider to 
enhance secondary colors. 

• Color Contrast — Enhances the color contrast in the image. Color contrast specifically refers 
to contrast that is created between differences based on colors (vs. luminance). The more 
you use the slider, the more contrast between primary and secondary colors. 

__________________________________________________ 
TIP 
Vibrance can be used in conjunction with Saturation to make secondary colors pop a little more. 
Application of Color Contrast is also recommended to obtain realistic contrast and color saturation 
of the picture. This slider is very helpful, especially if the color temperature is incorrect — make any 
corrections here at the very start of editing, before further image adjustment is applied. 
__________________________________________________ 
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HDR Enhance 
This tool allows adjustment of image detail and clarity. Using this tool you can get a classic HDR 
effect with great detail or get a smoother picture with less detail. This is the main tool to increase 
micro-contrast of the image and visualize more details. 

HDR Clarity Section 
The HDR Clarity slider is a single slider that adjusts a variety of controls including lighting effects 
and detail.  It offers a special ability to configure balanced image brightness without getting 
completely white or completely black areas. This has the effect of making the image less realistic 
and more classically the look a lot of people associate with HDR. 

HDR Smart Structure Section  
Increases image detail by revealing the structure and texture of the surfaces in the image. This 
enhances the image and hidden details appear. This slider adjusts the overall display of details. 
Moving the slider to the right will accentuate details and make the image more unrealistic. 

HDR Microstructure Section 
This section amplifies micro-detail within the image. These are small details that form the surface of 
any object in the image. They can further enhance details of the image and provide a more vivid 
artistic HDR effect, however it can also make the image very noisy. 

• Amount — Increases micro-details and contrast 
• Softness — Affects the general "softness" and realism of the photo. Moving the slider to the 

left will cause the image to become very finely detailed and unrealistic. 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HDR Denoise 
This tool slightly blurs the image and,reduces the amount of noise and any image artifacts caused 
by merging multiple exposures together. However, special algorithms also attempt to preserve 
edge detail if possible. It can also be used to reduce the amount of noise which may have been 
caused by increasing detail within the HDR Structure section. 

• Amount — The strength of reduction of small noise in the image Moving the slider to the 
right will increase noise reduction. Note: the Amount slider must be moved above 0 to 
notice results. 

• Smooth — This slider allows you to make the image more blurred which has the effect of 
creating a less detailed or noisy image.  

• Boost — Adjusts the overall display of noise When the slider is moved to the right, allows the 
full effect of the de-noise control to be shown. 

__________________________________________________ 
NOTE 
It’s helpful to apply this tool not to the entire image, but locally: Create a layer in which you’ll apply 
the effect. Then using a mask, brush only the area where the effect should be applied. For example, if 
the noise is very noticeable in the sky, use a mask to apply the effect to the sky. This effect should 
never be applied to the entire image — otherwise too much detail will be lost. 
__________________________________________________ 
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LUT Mapping 
Use professional lookup tables to change the appearance of your photo quickly.  Choose from film 
stocks, black and white looks, and create color grades to unlock a new style in seconds. You’ll find 
several built-in styles in the pop-up list, you can also load your own lookup tables in .cube,  
.3dl, or .look format. 

• Amount — This lets you reduce or increase the intensity of the Lookup Table. 

__________________________________________________ 
Note 
If you choose a custom LUT it will automatically be stored with your saved Aurora HDR file or 
embedded into any custom Look that you create. 

__________________________________________________ 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Image Radiance 
This tool provides a soft glow effect to the image, adding more vibrant colors with an increased 
global contrast. Moderate use of Image Radiance can give you more interesting, entertaining or 
“dreamy” images. 

• Amount — Effect strength For a moderate effect and a more realistic image, keep the values 
in the Amount to +40. If the Amount value is 0, then the effect is not applied. Move the slider 
to the right to increase the Amount. 

• Smoothness — Controls the softness of the effect 
• Brightness — Controls the brightness of the effect 
• Shadows — Controls how the affect modifies darker areas of the image A higher value will 

brighten dark areas. 
• Vividness — A useful way to adjust the color saturation of the effect applied to the image 
• Warmth — Adjusts the hue of the effect towards the warm end of the scale 

__________________________________________________ 
TIP 
At a low setting, this effect will give the image more contrast and can increase color in the image. 
Use the Vividness slider for better control. 
__________________________________________________ 
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Polarizing Filter 
On a camera, a polarizing filter can provide more color depth and cuts atmospheric haze, resulting 
in richer, bluer skies. The same holds true for the Polarizing Filter in Aurora HDR 2019.   The effect 
will produce deeper blue skies and more contrast in clouds. With a light touch of this filter, almost 
any landscape image can be improved.   

• Amount — Effect strength. If the Amount value is 0, then the effect is not applied. Move the 
slider to the right to increase Amount. 

__________________________________________________ 
NOTE 
It is not recommended to use this tool on night photos or images without sky in them. Most often, 
keeping the effect intensity under +50 will yield the best results. 
__________________________________________________ 
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HDR Details Boost 
This filter allows you to control the details of the image, making it more clear and sharp, or vice 
versa, softer. This tool is useful for improving the overall quality of the image as well as increasing 
the quality of the images used in high resolution, such as for printing. Increasing the sharpness can 
also compensate for any lower quality optics used to make the captured image.  
Innovative technologies allow the HDR Details Boost adjustment to improve image sharpness 
without increasing digital noise or creating unnatural ghosting or halos in the image. This is a very 
powerful tool to improve the quality of images. 

• Small — This sets the sharpness of fine details. At 0, the effect is not applied. Moving the 
slider to the right will intensify the clarity of small details, while moving it to the left, will wash 
out the fine details. 

• Medium — This sets medium-sized parts sharpness. At 0, the effect is not applied. Moving 
the slider to the right increases the sharpness, while moving the slider to the left - decreases 
it. 

• Large — This sets the sharpness of global contours of the objects in the image. At 0, the 
effect is not applied. Moving the slider to the right increases the sharpness, while moving it 
to the left — decreases sharpness 

• Protection — This slider will protect fine details from being negatively adjusted. 
• Masking — is a separate slider. This slider controls the zone of detail amplification. When 

moving the slider to the left, the number of zones increases and the image becomes more 
detailed. When moving it to the right, the number of granularity zones is reduced. Optimal 
masking comes from a setting in the range between 30 and 70. 
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Chapter 10 | Using Filters
__________________________________________________ 
NOTE 
A moderate increase in Small and Medium has positive impact on the sharpness and quality of any 
image. There is often no need to demonstrate all details in the image.  
In bright areas, such as the sky and light clouds, unnecessary detail will reduce realism. The dark 
areas often need more detail. Therefore, it is always better to strengthen details in the shadows vs. 
lights. 
__________________________________________________ 
TIP 
Should you desire an image that is soft, you can achieve that effect by moving the Detail sliders to 
the left.  By default all sliders are at 0 and at that setting have no effect. The effect is only visible after 
moving sliders to the left or right. 
__________________________________________________ 
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Glow 
The Glow tool adds auras to the picture. The effect finds the brightest areas of an image and adds 
bright halos to it, adding the effect of shine. This effect can be used to give the photo a "romantic" 
look or create a fog effect. This effect works on night photos to accentuate glowing halos around 
light sources such as street or building lights.  

• Amount — Sliding this control to the right increases the strength of the glow around areas of 
high brightness. 

• Smoothness — This slider controls the size of halos around bright areas. Moving the slider to 
the right increases the size of the halos. 

• Brightness — This slider analyzes the image and determines where halos will be created, 
letting you choose the areas of brightness that should be lightened up. Moving the slider to 
the left ensures areas of maximum brightness will be selected. This locates the glow just 
around the brightest areas. Moving the slider to the right will include darker areas to apply 
glow. Moving it all the way to a value of 100 will light up the entire image. 

• Warmth  — By default, a neutral white color is used for the glow in the middle of a halo. This 
slider allows you to select a specific hue for the glow using the cool-to-warm spectrum 
shown on the slider. 

__________________________________________________ 
NOTE 
This effect can be a powerful tool for creative photo processing. When you move the Brightness 
slider to 100 and increase Amount, you get a misty or foggy effect in the picture. By increasing the 
Amount, detail in bright areas is not lost, but rather highlighted. 
__________________________________________________ 

Aurora HDR 2019 User Guide Page !  of !48 103

Im
ag

e 
by

 D
im

a 
Sy

tn
ik



Chapter 10 | Using Filters

Adjustable Gradient 
This tool is a simulation of an analog filter which can specify different levels of brightness in the 
picture vertically - the Graduated Neutral Density Filter. This effect is widely used in landscape or 
architectural photography using a distinct horizon. The effect flexibly and separately controls 
brightness and other aspects at the top and bottom of the image.  
This enables you, for example, to lower the brightness of the sky and raise the brightness of the 
foreground. Thus, your image can be significantly improved without resorting to creating layers and 
masking. 

Note: The explanation of the controls are the same for Top & Bottom sections of this panel. 
• Set Orientation — On a Mac, click this button to interactively drag the position of the filter. 

• Drag the Move arrows to position the Transition Zone. 
• Place your cursor next to the Move tool and it changes to allow for Rotation of the 

Transition Zone. 
• Expand or contract the Blend handles to adjust the rate of transition from top to bottom. 

Expand the bars to increase the Blend value, making the transition between the values of 
Top to Bottom wider. Decrease the spread to decrease the blend value creating a sharp 
transition between Top and Bottom. 

• On Windows, use sliders to control the orientation of the Gradient. 
• Exposure — This controls the brightness of the image. Moving the slider to the left will make 

it darker and to the right brighter. 
• Contrast — This adjusts the contrast of the image. Contrast is the difference in luminance or 

color that makes objects in an image distinguishable from another. 
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Chapter 10 | Using Filters
• Highlights — This refines the brighter regions of an image with a targeted adjustment to 

lighten or darken with gentle blending. 
• Shadows — This slider targets the darker areas of an image with a targeted adjustment to 

lighten or darken with a smooth transition. 
• Vibrance — This slider makes less vibrant colors stronger and has a weaker effect on more 

vibrant colors. This allows you to achieve more realistic and avoid oversaturated colors in the 
image. 

• Warmth — This adjusts the hue of the effect towards the warm end of the scale. 
__________________________________________________ 
NOTE 
This tool is best suited for landscape shooting with a strong horizon line. With it, you can lower the 
brightness of the sky at the top, and then, using the Set Orientation button or sliders to  position the 
strip of brightness transition between heaven and earth approximately at the level of the horizon. 
__________________________________________________ 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Tone Curve 
One of the most powerful tools for adjusting tones to brighten, darken, add contrast and shift 
colors. Curves can usually be applied to all channels together in an image, or to each channel 
individually. Curves can help you manually fine-tune the brightness and contrast of the image. 
Users will either use Curves a lot or they won’t use it at all. The Curves interface is a bit complex and 
allows for up to 10 control points. This can significantly open up more options when adjusting color 
and exposure. The primary advantage of Curves is that you have precise control over which points 
get mapped for tonal adjustment. 

• Tabs — You can make a curve adjustment to all channels equally or to an individual channel,
(such as to blue, to emphasize the sky). Just click on the White dot for a global adjustment 
or use the Red, Green, and Blue dot to adjust the corresponding channel. 

• Sliders — At the bottom there are sliders that let you adjust the black and white points of the 
histogram, (the leftmost and rightmost sliders), as well as the middle bend of the curve (the 
central slider). 

• Points — You can add up to 10 control points.  Drag up, to add contrast to an area and down 
to lighten the area. Multiple points can be employed for contrast adjustments based on 
tonal range. 

__________________________________________________ 
TIP 
Many, many articles are available on the Internet for information on using this tool. Generally moving 
a slider down will darken that channel and moving it up will lighten the channel. Experiment and 
have fun! 
__________________________________________________ 

Aurora HDR 2019 User Guide Page !  of !51 103

Im
ag

e 
by

 D
im

a 
Sy

tn
ik



Chapter 10 | Using Filters

HSL (Hue, Saturation, Luminance) 
This tool allows for separate adjustment of the hue, saturation and brightness of the main colors in 
the image. There are three tabs present in the Color Filter panel. Each tab contains sliders for Red, 
Orange, Yellow, Green, Aqua, Blue, Purple, and Magenta values. 

• Hue — A set of sliders to adjust the hue or basic color shades of your image Sliding the 
control further to the right results in a more intense hue. 

• Saturation — A set of sliders to adjust color saturation Sliding the control further to the right 
results in a more intense color. Of course, moving to the left removes color to the point 
where -100 will make the image appear black and white. 

• Luminance — A set of sliders to adjust the brightness of the colors. Sliding the control further 
to the right results in a brighter color within the image. The further to the left, the darker the 
image. 

__________________________________________________ 
NOTE 
This is a powerful tool for fine-tuning colors in the image as well as a means for creative image 
processing. It is found in several other popular photo apps such as Adobe Lightroom.  
Examples of using this tool: 

• When the sky is mostly blue in the photo. Lowering the brightness of blue colors in the image 
can darken and deepen the blue of the sky. 

• Reducing the tone for some colors (move the slider to the right in Saturation tab), and leaving 
it for the other can create a dramatic effect on the selective color in photos. 

• Raising the yellow color (move the slider to the right) can significantly improve the color 
saturation of autumn foliage in images. 

__________________________________________________ 
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Color Toning 
This tool affects the color toning of images. The color shade in the Highlights area is for the light 
areas in the image and the Shadows area color shade is for the dark areas. The effect can 
significantly increase the visual appeal of images, and is often used for creative artwork or to 
simulate analog photography techniques (e.g., a vintage look). 

• Amount — Controls the overall intensity of the filter 

Highlights Section  
Highlights set the color for the bright colors in the image. 

• Hue — Move the slider to target the corresponding hue that you want to modify.  

• Saturation — This slider lets you choose the saturation level of the Highlights color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. Therefore, to use 
color, you must choose both Hue and Saturation. 
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Shadows Section 
Shadows sets the color for the dark tones in the image. 

• Hue — Move the slider to target the corresponding hue that you want to modify.  

• Saturation — This slider lets you choose the saturation level of the Shadows color shade. If 
the value of saturation = 0, white is used and toning is not noticeable. Therefore, to use 
color, you must choose both Tint and Saturation. 

General Control 
• Balance — Sets the balance between light and dark tones. If you move the slider to the right, 

more tones are considered bright and therefore the color chosen for the bright areas 
(Highlights) are emphasized in the photo. Move to the left and more tones are considered 
dark and the color chosen for dark tones (Shadows) are emphasized in the photo. Thus it is 
possible to balance what color is used to tone the image. 

__________________________________________________ 
NOTE 
The best results are achieved if you use colors opposite to the bright and dark areas, for example: 
yellow and blue, green and purple. 
Use warm tones for light colors and cool ones for the shadows. Only light or only dark areas of the 
image can be toned. To avoid toning of certain areas, simply set Shadows or Highlights saturation 
parameter to 0. The color is not applied. 
__________________________________________________ 
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Dodge & Burn 
Dodge & Burn tools are known as toning tools. They allow for finer control over lightening or 
darkening an image. These tools simulate traditional techniques used by photographers. In the 
darkroom, the photographer would modulate the amount of light on a particular area of a print.   

1. Click Dodge and Burn, to expand the Dodge & Burn section in the Filters list. 

2. Click the Start Painting button to open up your canvas. 

3. Choose either the Lighten or Darken tools in the top toolbar to select the desired brush. 

4. Use the Size slider in the Toolbar to control how large the brush is. 

5. Use the Strength slider to control its impact. 

6. If you get an accidental stroke, the Erase tool can be used to remove it. 

7. Click Reset if you need to start over. 

8. Click Done to apply the adjustment. 

9. Use the Amount slider in the filter control group to further refine the global intensity of 
the filter and blend it back into the original image. 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Chapter 10 | Using Filters

The image on the left is the tone mapped file before applying the Dodge & Burn effect.  Using the brush 
tools, areas like the pool and sky were selectively darkened (Burn) while other areas like the foreground 
were lightened (Dodge). 

__________________________________________________ 
NOTE 
This tool is meant to be used creatively and by feeling.  It is more about the look and result than 
ispecific numbers and slider settings. Feel free to experiment as you can always adjust the mask of 
the Dodge & Burn effect as well as its overall opacity. 
__________________________________________________ 
TIP 
Double-clicking on any slider name resets the value to the default. In most cases, double-clicking 
returns it to 0. 
__________________________________________________ 
TIP 
If you press and hold the Option key and click on a slider value in the sidebar, moving the cursor to 
the left and right will allow you to set the values of the slider with higher accuracy. Slider sensitivity 
becomes higher than with normal movement. This allows you to fine-tune by smaller numeric values. 
__________________________________________________ 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Vignette 
A Vignette darkens or lightens the edges of your image. This is quite an old technique to emphasize 
the accents on photos. The effect typically leaves the central area unaffected while the edges are 
shaded or lightened. Aurora HDR goes further by letting you place the center point of the vignette 
anywhere in the image you like. 

• Type You can choose to calculate if the vignette should respect cropping of the photo or 
use its original borders. 

• Amount Strengthens the darkening around the edges of photos In position 0, the effect is 
not applied. Move the slider to the left side of the picture to give more shading to the edges, 
or move the slider to right to brighten the edges. 

• Size  Determines the size of the obscured area Moving the slider to the left will increase the 
area of darkening. Moving the slider to the right will reduce the area of darkening. 

• Roundness  This slider changes the shape of the shaded area. 
• Feather This slider sets the smoothness of the transition between the areas of shading. 
• Inner Brightness  This slider increases the brightness in the central region which is not 

affected by shading. It allows you to create a contrast effect. 
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Chapter 10 | Using Filters
• Place Center Button This control adjusts the 

center of the effect. By default, the center of 
shadowing effect is in the center of the 
image.  
With this button you can shift the focus from 
the center of the image to any other place.  
 
Click the button Place center to turn the 
cursor into a “target sight.” Then click 
anywhere in the image to set the new center 
of your shading effect. 
 
This control is not yet available on Windows. 

__________________________________________________ 
TIP 
This tool allows you to highlight key points in the photo, making it more interesting. Slight edge 
shading always encourages the viewer's eye to consider the lighter central part of the photo. You can 
also move the center to focus attention on objects that are not in the middle of the picture. For a 
realistic picture, don’t lower the Amount below -50. As a rule, use this effect only with darker shading. 
Highlights are rarely used except for some vintage looks. 
__________________________________________________ 

The image on the left has no vignette applied. The image on the right uses an off-center vignette to draw 
attention to the hanging chandelier. 
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Working with Layers 
Each layer can contain discrete elements of your project. Layers can contain photos, textures, or 
adjustments. There are lots of ways to create and manage layers, but it all comes back to having an 
organized design. Be sure to double-click on the name of each layer and give it a clear, descriptive 
name to make your workflow easier. 

Using Layers 
Let’s explore using Layers. To make sure Layers are visible, do the following: 

1. Launch Aurora HDR 2019 and open an image. 

2. If Layers aren’t visible, click the Side 
Panel button in the top toolbar to 
open the panel.  You can also press 
the Tab key to open the Side Panel if 
it’s hidden. 

3. If Layers still aren’t seen, click the 
Layers button in the Side Panel to 
view Layers.  

4. Review the Layers group. When you 
first open an image, it’s named 
based on the source file.  This base 
layer can have filters applied directly 
to it or you can add more layers 
above it.  Each new layer uses the 
previous layer below as it's starting 
point. In other words, each layer 
imposes the result of it's processing 
on the previous layer. 

5. To add another layer, click the + 
button at the top of the Layers 
controls.  You can add an: 

• Adjustment Layer  

• New Image Layer 

• New Original Image Layer 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Using the Add New Image Layer Command  

The Add Image command is a useful way to add one image on top of another in an Aurora HDR 
2019 image project.  There are many possible reasons to do this, including design and technical. In 
this chapter we’ll explore two uses of this effect. 

Loading a Texture Layer 
The use of texture layers is quite a useful way to stylize an image.  You can use the Add Image 
command to place a texture above a photo. 

1. Click the + symbol at the top of the Layers panel and choose Add New Image Layer…. 
2. Navigate to a texture image on your hard drive and click the Open button to add the file to 

your document.  The layer is automatically named with the file name of the selected file. 
3. To scale the texture, right-click on its thumbnail and choose Image Mapping. 
4. Select one of the three mapping options.  You can Fit the image to the width or height, use 

Scale to Fit to enlarge the image to fit the screen, or use Fill to distort the image to fill the 
screen. 

5. Click the Blend menu to change the Blending mode for the Texture layer. 
6. Drag the Opacity slider to refine the blending of the two layers. 
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As you adjust the blend mode and opacity of the texture layer, it will create many different creative 
effects. Each mode will have a different impact on your image based on the type and opacity you 
choose. Adding a texture to your image can dramatically change the look and feel of your work, 
plus, you may want to use a brush to apply the texture to only specific areas of your image. 
__________________________________________________ 
NOTE 
Textures are not stored in Aurora HDR 2019. These files are located wherever you’ve saved them for 
usage. For easy access, we recommend keeping all of your textures in a consistent place on your 
hard disk. 
__________________________________________________ 
TIP 
Single View Mode, accessed from the View menu, displays adjustment controls for only the 
selected tool in the Tools Sidebar. With this viewing option, all the tools, except the current one, are 
closed. Click on a different tool and the current one will be closed and the new one opened. In this 
mode, only one control is visible at a time, cleaning up the sidebar interface significantly. This 
command is not yet available on Windows. 
__________________________________________________ 
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Adding a Watermark or Logo 
A logo or watermark is an excellent way to brand an image before you post it to the Internet or 
make a print. You can use the Add Image command to place a watermark or logo to a photo. 

1. Click the + symbol at the top of the Layers 
panel and choose Add New Image 
Layer…. 

2. Navigate to a logo or watermark on your 
hard drive and click the Open button to 
add the file to your document.  The layer is 
automatically named with the filename of 
the selected file. 

3. To scale the texture, right-click on its 
thumbnail and choose Image Mapping. 

4. To prevent unwanted distortion of the 
watermark or logo, choose Fit.  

5. If the logo is over a white background, set 
its blending mode to Multiply to blend the 
background. If the logo is over black, set 
its blending mode to Screen. 

6. To scale the watermark, click the Transform Tool. 
7. Use the Scale and Rotate properties to size the logo. 
8. Use the X Offset and Y Offset to position the logo. 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Using an Adjustment Layer 
Aurora HDR 2019 offers a special type of layer that makes it easy to precisely edit your photos.  An 
adjustment layer can hold all of the filters available to you for a second instance.  You can disable 
any of the filters that you do not want to use. This is a really flexible way to work with your photos as 
it means you can easily control advanced options for filters such as their opacity, or blending 
modes.  Adjustment layers give you the most flexibility when editing a photo. 
Here’s how to work with Adjustment Layers. 

1. Open an image within Aurora HDR 2019. 
2. If hidden, open the Layers panel. 
3. At the top of the Filters section click the + button. 
4. Choose the item Add New Adjustment Layer. 
5. To make things easier, be sure to give the new 

adjustment layer a descriptive name. You can 
right-click on the layer and choose Rename to do 
this.  Type in a new name and then press the Enter 
or Return key. 

6. The new layer contains access to all of the filters. 
Adjust any of them to modify to taste. 

7. Disable any filters you do not want to use by 
clicking their visibility icon (eyeball). 

8. Use advanced controls to refine the look of the filter such as the layer’s Blending Mode or 
Opacity and opacity settings. Continue to add additional effects as needed to their own 
adjustment layers. 

9. As needed, you can turn layers on or off to alter the image’s appearance.  You can also drag 
adjustment layers up or down in the layer stack to generate new effects. 
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Using Blending Modes with Layers

A blending mode compares the content of two layers and enacts changes based upon the content 
of both. You can choose from 14 different blending modes using the pop-up menu at the top of the 
Layers controls.  Understanding blending modes requires a bit of science.  To start, let’s establish 
three key terms. 

• Base color – The original color in the image 

• Blend color – The color being applied by the top layer or adjustment layer. 

• Result color – The color resulting from the blend 

To adjust a layer’s Blending Mode: 
1. Open a photo within Aurora HDR 2019. 
2. In the Layers controls, click the + button and choose the Add New Image Layer option or 

Add New Adjustment Layer. A new layer is added to your project. 
3. For the top layer, click the Blend pop-up menu in the Layers control area.  
4. Choose from one of the 14 available blending modes. 
5. Experiment with the Blending Mode and Opacity settings to create new looks. 
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Normal 
The default mode performs no additional change to the way layer contents interact. 

Darken 
Pixels lighter than the blend layer are replaced, darker ones are not. 
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Multiply 
This is similar to drawing strokes on the image with markers. The colors of the top layer are blended 
with the image. 

Color Burn 
Evaluates each channel; darkens base by increasing contrast. 
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Lighten 
Evaluates each channel; it then uses base or blend color (whichever is lighter). 

Screen 
Uses a lighter color. It is useful for “knocking” black out of a layer. 

Aurora HDR 2019 User Guide Page !  of !67 103



Chapter 11 | Working with Layers

Overlay 
Overlays existing pixels while preserving highlights and shadows of base. 

Soft Light 
This effect is similar to shining a diffused spotlight onto the image. 
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Hard Light 
This effect is similar to shining a harsh spotlight onto the image. 

Difference 
Evaluates each channel and subtracts or inverts depending on brightness. 
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Subtract 
Looks at the color in each channel and subtracts the blend from the base.  

Hue 
Uses the luminance and saturation of the base and the hue of the blend. 
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Color 
Preserves gray levels. It’s very useful for coloring and tinting. 

Luminosity 
Has the inverse effect of Color mode. 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Working with Masks 
The use of masks allows you to hide or obscure parts of an image. Masks are useful to combine the 
contents or results of one layer with your primary image. Layer Masks allow you to use powerful 
painting tools to selectively enhance your images. The more you work with combining multiple 
images and editing specific areas, the more you’ll use masks.  

Creating a Layer Mask 
If you’d like to use a mask on a layer, the first step is to add one.  Any layer (even the base) can have 
a mask.  Masking the base layer blends the HDR photo with the original tone-mapped image.  
Masking additional layers blends with the images below. 
To add a mask: 

1. Open a photo or bracket series 
within Aurora HDR 2019. 

2. Select the desired layer. By 
default, layers and adjustment 
layers have no mask. 

3. Click the Edit Mask icon. A new 
menu opens below. There are 
four different masking modes to 
choose from that we’ll explore in 
this chapter. The toolbar 
contains several controls which 
we’ll explore next. 
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Painting and Erasing Masks 
Once you’ve started editing a mask, you can add or 
subtract using a variety of tools. Remember, to edit a 
mask, click the Edit Mask button to the right of a 
layer’s name and choose a tool to use.  

• Brush – Use a paintbrush to add or subtract 
from your mask. 

• Radial Mask – Creates an elliptical shape to 
blend between affected and unaffected areas 

• Gradient Mask – Creates a linear blend between affected and unaffected areas 

• Luminosity Creates a blended mask based on the light and dark areas of a scene  Try the 
Mask menu’s Invert command to reverse the mask. 

Once you’ve chosen one of the four tools, a new toolbar appears so you can customize the results.  
Let’s explore each control. 

Global Mask Controls 
The first two controls affect a mask’s properties globally. 
MASK MENU.  
Clicking this opens a contextual menu with additional options for working with the layer. 

• Fill – This option attaches a mask filled with white that reveals all details of the filter.  Use the 
Brush tool to paint with black and subtract from the mask. 

• Invert – Inverts any mask that you’ve created so that its opacity and transparency values are 
reversed 

• Clear Button – This option hides the results of the filter entirely.  Use the paintbrush or 
gradient tools to add details back to the image. 

• Copy – Copies the current mask to the clipboard To use this, create a new layer and paste it 
into the new layer. 

• Paste – Pastes the current mask stored on the clipboard for use on another layer 

• Show Mask – Makes the mask visible as a rubylith (red) overlay 

• Density – Controls the transparency of pixels outside a mask so that the overallmask fades 
into the background better 

• Feather – Blurs the edges of a mask to more naturally fade the mask adjustments into the 
image 
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VISIBILITY ICON (EYEBALL) 

This controls the visibility of the mask.  It makes it easy to view the mask as a rubylith (red) overlay. 
You may also continue drawing while the layer mask is shown, for even more precision.  

Using a Brush Mask 
The first type of mask is created by using a brush. Once you’ve chosen Brush from the pop-up list, 
you’ll see additional useful controls. 
The Brush can be used in either Paint mode or Erase mode to add to or subtract from areas of the 
mask. Clicking the Paint option will add white areas to the mask.  The white areas will preserve the 
current layer.  Brushing with Erase mode is handy for “trimming” overspray of the mask and makes 
your selection more accurate. 
To control a brush, click the Brush Settings dropdown menu, (it’s next to the Erase option). In this 
window, you can configure paintbrush settings such as Size, Opacity and Softness. If you have a Pen 
Tablet attached, you can also configure Pen Pressure, Radius and Opacity levels. 
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Here’s how to use the Masking Brush tool. 

1. Open an image or bracket series in Aurora HDR 2019. 

2. Click the Add Layer button (+ symbol) or choose Layers > Add New Adjustment Layer. 
Let’s add an obvious effect so that its easy to view.   

3. On the adjustment layer, apply the Warm Landscape Look for the Landscape category. 

4. Create a Layer mask by clicking the Mask button and choose the Brush option.  

You now have two options to decide how the initial mask is created. 
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• Paint – Clicking with the Paint tool fills the mask with black (hiding all of its results).  As 
you paint and add strokes they are added in white.  This method allows you to brush and 
add the results of the Adjustment layer selectively. 

• Erase – Clicking with the Erase tool fills the mask with white showing all of its results.  As 
you paint and add strokes they are added in black.  This method allows you to brush and 
subtract the results of the Adjustment layer selectively.  The erased areas will show 
through to the image below. 

5. Click the Visibility icon (eyeball) to view the mask. 

6. Brush with the Erase tool to subtract the results to the layer selectively. 

Aurora HDR 2019 User Guide Page !  of !76 103



Chapter 12 | Working with Masks

7. Continue painting the mask to get the desired results.  Use the toolbar at the top of the 
window to control the behavior of the Masking Brush tool. Click the Brush drop-down menu 
to control the shape and dynamics of the brush. 

• Size – Controls the diameter of the brush  You can also use the keyboard shortcuts 
[ and ] to make the brush smaller or larger. 

• Softness – Controls how much blending there is between the center of the brush and its 
edges  This can create a more gradual blend on any mask.  You can also use the 
keyboard shortcuts Shift + [ or ] to make the brush harder or softer. 

• Opacity – This controls the overall opacity of the brush.  A brush at 100% has full impact.  
A brush set to 50% will add or subtract half of its strength. 

• Presets – In the center of the grid there are various preset brushes for quick selection. 

• Pen Pressure – If you have a Pen Tablet attached, you can also configure Pen Pressure, 
Radius and Opacity levels. This allows you to draw on the tablet and have the force 
applied to the pen transferred to the size and density of the brush. 

8. Click and paint on the canvas to modify the selected mask layer or adjustment layer. 
9. Toggle the mask visibility off by clicking the Visibility icon (eyeball) on the toolbar.   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10. To refine the mask even more, click the Gear icon then select Density and Feathering for 

the mask.  This can control how the mask is applied and helps blend results. 
• Density – Controls the transparency of pixels outside of a mask so that the overall mask 

fades into the background better. 

• Feather – Blurs the edges of a mask to more naturally fade the mask adjustments into the 
image. 

11. If you choose to remove a mask, right-click on the Mask icon in the Layers panel and 
choose Clear to remove it. 

12. Refine the Opacity of the Adjustment Layer as needed to get the desired effect. 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Using a Radial Mask 
A Radial Gradient Mask is a quick, easy 
way to highlight the sun, a face or 
anything else on your photo.  You can 
create an ellipse or circular shape that 
makes its easy to create a gradual blend 
between two states.  It can also be used 
with an image layer to add ramping 
transparency.  For an adjustment layer, 
it’s useful to create a blend between the 
modified and original state.  
Here’s how to use the Radial Mask tool: 

1. Create a Layer or Adjustment 
Layer mask as previously 
discussed in this chapter.   

2. Click the Edit Mask button on the layer. 
3. Select the Radial Mask option from the Tools dropdown. 
4. Click and drag to create a circular gradient.   
5. Click the Visibility button in the top toolbar to make it easier to visualize the gradient. 
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6. The tool offers simple controls to refine the gradient. 

• Drag the middle of the gradient, (the dot) to place its center. 

• Drag the inside circle’s radius to affect the size of the gradient. 

• Drag the outside circle’s radius to affect the feathering of the gradient. 

• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag outside the outer circle to rotate the gradient mask. 

7. You can change the mode of the mask if you need to change how a mask is applied by 
clicking the Invert button. By default, the Radial Gradient mask that is created will “protect” 
the center of the circle/oval and any enhancements will be applied outside of the inner 
circle. Click this button to invert the mask so that effects will be applied to the inner circle. 

8. When satisfied with the mask, click the Done button.   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9. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 

its results are applied. If using an image layer, you can control the opacity and blending 
mode of the layer. 
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Using a Gradient Mask 
The Gradient Mask Tool is useful for creating a gradual blend between two states.  It can be used 
with an image layer to add ramping transparency.  For an Adjustment Layer, it’s useful to create a 
blend between the modified and original state. The Gradient Mask is a favorite tool of landscape 
photographers that allows you to adjust images smoothly with effects only applied to the gradient. 
Here’s how to use the Gradient Mask tool: 

1. Create a Layer or Adjustment Layer mask as 
previously discussed in this chapter.   

2. Click the Edit Mask button on the layer. 
3. Select the Gradient Mask option from the 

drop-down. 
4. Click the Visibility button in the top toolbar to 

make it easier to visualize the gradient. 
5. Click and drag to create a linear gradient.   
6. The tool offers simple controls to refine the 

gradient. 

• Drag the top bar or bottom bar to expand or contract the gradient. 

• Drag the middle dot to position the gradient. 

• Drag the bottom bar to move the end of the gradient 

• Click and drag just outside the centerpoint to rotate the gradient mask. 

• Drag a handle on the outside circle to adjust the aspect ratio to create an ellipse shape. 

• Drag outside the outer circle to rotate the gradient mask. 
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7. When satisfied with the mask, click the Done button.   

8. If using an Adjustment Layer, adjust the Filter controls as needed.  The mask will control how 
its results are applied. If using an image layer, you can control the opacity and blending 
mode of the layer. 

__________________________________________________ 
TIP 
You can edit the results of a Gradient mask by clicking the Edit Mask button.  This lets you add or 
subtract from the mask using the Brush tool for greater control over the mask. 
__________________________________________________ 
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Luminosity Masks 
A Luminosity Mask is a fast and easy way to create a new mask based on the brightness of image 
pixels.  When selected, the command will fill the active layer with a mask based on the brightness of 
image pixels. The transparency for the layer is directly related to the brightness of the pixels. 
This command works very well to mask an overlaid image such as a cloud or texture layer. You can 
also mask a copy of a layer to enhance only part of an image. For example, if the sky and clouds are 
bright, you can create an exact mask for that area of the image only and then enhance them. 
Heres how to create a Luminosity Mask: 

1. Open a photo or bracket series within Aurora HDR 2019. 
2. In the Layers controls click the + button and choose the Add New Image Layer option. 

In this example a texture layer was added. 

3. For the desired layer, click on on the Edit Mask button and choose Luminosity. 
A new mask is created based upon the brightness 
values of the image. 

4. If the mask is showing unwanted areas, you 
can right-click on the layer’s name and choose 
Mask > Invert. 

5. You can also re-run the Create Luminosity 
Mask command multiple times to generate 
different masks each time. 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6. Use the layer’s blending mode and opacity sliders to blend the layer to taste. 

Masking Options 
Here are some extra techniques you can use when masking a layer or adjustment layer. 

• While masking or erasing, right-clicking the mouse causes a context window of parameter 
settings for the brush and includes additional controls for pen pressure sensitivity. 

• For handy reference, in the Layers panel on the upper right side of the Side Panel, you’ll see 
a thumbnail image of the current mask. 

• To quickly switch between Paint and Erase modes, use the shortcut key X. 

• To quickly change the Diameter of the brush, use the shortcut keys [ and ]. This is very 
convenient and greatly speeds up brush work. 

• To quickly change the Softness of the brush, use the shortcut keys Shift + [ and Shift + ]. 

• If you hold down the space bar in Painting mode you can switch to a Move Image mode.  
This is very convenient when zoomed in for detailed brush strokes. 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Crop & Transform a Photo 
Directly out of a camera, your digital photos will likely not be sized to the exact dimensions you 
need.  Between different shaped screens, web pages, social networks, and prints, it’s common to 
change the shape and size of an image. Inside of Aurora HDR 2019 you have options such as 
cropping which changes the shape of a photo, and transforming which scales the image inside the 
canvas. You can use these choices individually or in combination to achieve the desired results. 
Additionally, a photo can be transformed to counteract lens issues. 

Cropping a Photo 
With the Crop tool you can change a viewer’s perception of an image. You can choose to tighten 
the area of interest, which allows you to de-emphasize (or even eliminate) parts of a photo and 
improve the image by better framing the subject. An additional benefit is that the Crop tool can 
also be used to align (straighten) the horizon in an image. 

1. Open an image that needs cropping or straightening. 
2. Switch to Crop tool by click the Scissors button in the top toolbar or press the C key.  

After pressing this button, the application enters Crop Tool Mode. 

3. Examine the top Info Bar which displays all functions for cropping an image. 
4. Choose a ratio from the Aspect drop-down menu. 

• Free – Create a custom shape by dragging to taste. 
• Original – Preserves the original shape of the photo but allows you 

to crop more tightly to remove details from the edges 
• Transposed – The original dimensions are reversed for the crop. 
• 16:10 – A ratio that matches many computer displays 
• 16:9 – A ratio used by televisions, many electronic devices and 

presentations 
• 11:8.5 – A common size for documents. 
• 7:5 — A rectangular image that’s common for many photo sizes 
• 5:4 – A nearly square image that’s common for many photo sizes 
• 4:3 – A rectangular image that’s common for many photo sizes 
• 3:2 – A rectangular image that’s common for many photo sizes 
• 1:1 – A square shaped image 
• 2:3, 3:4, 4:4 5:7, 8.5:11, 9X16, and 10:16 – Presets that match the 

standard print and screen ratios, but with their values transposed 

• Facebook Cover – A useful size for a page banner on Facebook™  
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• Facebook Feed – A common size for an image post to Facebook 
• Enter Custom… – Offers the ability to choose a specific aspect ratio 

5. Choose a ratio overlay to help with cropping. 
• Rule of Thirds – This is an over-used standard for cropping. The four intersecting points 

are considered  the best place to put a subject.  Many feel that following these guides 
makes an image appear better. 

• Phi Grid — The phi grid is similar to the rule-of-thirds grid. The differences are that the 
parallel lines are closer to each other and to the center of the frame, and the nine boxes 
are not all the same size. This grid can better accommodate the Golden Ratio.  Many 
landscape photographers feel that this is a better guide for composition than the rule of 
thirds.  

The Rule of Thirds overlay on the left is the default overlay when cropping. The Phi Grid on the right is an 
alternative overlay to help when cropping. 

6. Drag any of the corners or resize handles to modify the cropping rectangle. 
7. To Move the image inside the crop, just click inside the image crop area and drag to 

reposition the image “behind” the cropping rectangle. 
8. To Rotate an image, you can click on the Angle readout to reveal a drop-down slider for 

adjusting the angle of the image up to 45 degrees in either direction. You can also click and 
drag just outside a corner to rotate.  A grid overlay appears to help you with accurate 
cropping. 

9. When happy with the 
cropping, click the Done 
button. To cancel this action 
click Cancel.  
If you do not like the result, 
you can easily undo the 
cropping by clicking the 
Undo button. Hence 
cropping is a safe operation 
that can be easily undone. 
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Additional Options When 
Cropping 
Inside the Crop tool, you’ll find a few other 
useful commands. 

• Click the Flip button to reverse the 
left and right sides of the image. 

• Click the Flop button to reverses the top and bottom parts of an image. 

• Click the Rotate button to turn the canvas in 90˚ increments. 

Transforming a Layer 
Once you’ve merged brackets, opened a 
photo, or added a new layer to a document, 
it’s easy to transform it.  With the Transform 
tool there are many options available for 
changing the position, rotation, and scale of a 
layer. 

1. Open a photo or merge a series of 
brackets to create a new image. 

2. While on the base or initial layer, click 
the Transform button near the top of 
the Filters controls. 
The image can now be transformed. 

3. Adjust any of the following properties 
as needed to transform the image: 
• Vertical – This tilts the image by 

rotating it on the X-axis.  This tilts the image forwards or backwards and can help 
compensate for an image with any keystoning problems.  This type of problem causes 
vertical lines to appear skewed and is often caused by the camera shooting from an 
angle by rotating on the Y-axis.  This angles the image from side to side and solves the 
problems caused by shooting at an angle above or below in relation to the subject. 

• Horizontal – This adjustment tilts the image on the Y-axis.  It can help compensate for 
perspective issues caused by shooting off-angle from your subject. 

• Rotate – Rotates the entire canvas on the Z-axis and can be useful for straightening a 
crooked photo. 

• Aspect – This command changes the aspect ratio of a photo. Dragging the slider will 
expand the height or the width while contracting the opposite direction for the second 
value.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                

• Scale – Use the Scale command to effectively crop the transformed photo.  This is a 
useful way to hide gaps after transforming a photo. 
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• X Offset This shifts the transformed image left or right. 
• Y Offset This shifts the transformed image up or down. 

4. When finished, click the Done button to use the Transform settings. 
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Applying Lens Correction to a Layer 
The new Lens Correction command easily fixes all kinds of lens distortion, from barrel and 
pincushion to chromatic aberration and vignetting.  
This is a useful way to compensate for flaws caused 
by the lens. 

1. Open a photo or merge a series of brackets 
to create a new image. 

2. Click the Lens Correction button near the 
top of the Filters controls. 
The image can now be corrected.  Any filters 
applied will be temporarily disabled while in 
Transform mode. 

 

3. Adjust any of the following properties as needed to transform the image: 
• Distortion – Drag to the left to increase the barrel shape of the lens.  Drag to the left to 

pinch and compensate for wider angle lenses. You may need to crop the layer or use the 
Scale command in the Transform controls to compensate for gaps at the edges. 
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The image on the left shows distortion from a wide-angle lens.  On the right, some of the unwanted curvature 
has been corrected. 

• Defringe – This option is useful to remove fringe colors along edges.  This can occur 
along detailed edges in a subject, especially where there’s a sharp change in color 
values. 

• Remove CA (Chromatic Aberration) – Chromatic aberration is another type of color 
fringing.  It often happens on telephoto lenses and in areas of high contrast.  It tends to 
show up as magenta or green edges. 

• Devignette – Removes any darkening at the edges of an image caused by the lens itself.   
This is a corrective command, not a stylizing command.  If you want an artistic vignette, 
use the Vignette filter. 

The image on the left shows darkening along the outer edges caused by the lens.  The image on the right has 
had its edges lightened with the Devignette command.  If you want a stylistic vignette, use the Vignette filter. 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Saving and Exporting Files 
As you work with digital images, at some point you’ll reach a point where saving a file is a good 
idea.  It might be an in-progress save to capture work to date as you edit a photo.  Perhaps it’s to 
prepare a file for printing or sharing on the Internet.  Or maybe you’d like to export to social media.  
Aurora HDR 2019 offers many different options for saving and exporting images to meet your 
needs. 

Saving a Native Aurora HDR File for Future Edits 
As you design using layers, filters, and masks, then it’s a good idea to capture that work from time-
to-time. To make this easy, Aurora HDR 2019 offers a native file format, the Aurora HDR 2019 project 
file, (its file extension is .mpaur2).   

1. To save your work in progress, press Cmd+S / Ctrl+S on your keyboard or choose File > 
Save….  
A new dialog box opens. 

2. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
Cloud storage provider. 

3. Give the file a descriptive name. 

4. Choose Save original resources to Document if you want to include the information from 
the brackets or source files. 

5. Choose Save history if you’d like to include the ability to undo edits that you’ve made. 
6. Choose the Windows compatible option on a Mac to ensure cross-platform compatibility. 
7. When finished, click Save to write the file to disk. 

Your work is saved in its current state so that you can later continue from the same point.  
The file is saved in the proprietary Aurora HDR 2019 file format and cannot be opened with 
another application. For other software to use images created using Aurora HDR 2019, you’ll 
need to Export the file (see below). 
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Exporting Images 
While saving a native Aurora HDR 2019 file is important, you may also need to export multiple files 
for other tasks.  Maybe it’s to post online, to drop into a presentation, or to collaborate with others. 
When you export a file, you can save in a variety of file formats including JPG, TIFF, PNG and even 
PSD. 

Saving an Image File 
You can also save image files from your Aurora HDR 2019 project. These files are broadly 
compatible with many other applications. To create a new graphic file: 

1. It is suggested that you first save a native Aurora HDR 2019 project first using the File > 
Save command. 

2. To create a new graphic file choose File > Export… or click the Export button in the upper 
right of the interface.  A new dialog box opens. 

3. Choose a new location to store the saved file on your hard drive, an attached disk, or using a 
cloud storage provider. 

4. Select from the following optional items: 
• Sharpen – Choose whether you 

want to sharpen the exported file. 
This can increase details in the 
edges of the image and overcome 
some of the compression artifacts 
of formats like JPEG. 

• Resize – You can choose to export 
at the original size, or to enter a 
new dimension for the image to fit 
its long side or short side.  

• Color space – You can choose from 
3 color spaces for output.  sRGB is 
the narrowest color gamut, but 
most compatible with the web. 
Adobe RGB is a common color 
space used in computer graphics 
and many software applications. 
ProPhoto RGB provides the widest 
gamut and supports the broadest 
range of colors. ProPhoto RGB is the 
only color space that can contain all the colors captured in a raw format photo. 

• Format – Choose from eight different file formats.  Some options like TIFF and JPEG may 
offer additional settings for control over compression and bit depth. 

5. Give the file a descriptive name and click the Save button to write to disk. 
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Supported File Formats 
The following types of file can be created in Aurora HDR 2019. 

• JPEG (.jpg) – The Joint Photographic Experts Group (JPEG) format is most often used to 
display continuous-tone images (such as photos) on the Internet. Most digital cameras use 
JPEG because it provides excellent compression; the maximum setting provides 
comparable image quality to much larger file formats like TIFF. Occasionally, the print 
industry (especially newspapers) will use JPEGs. JPEG is a lossy compression, which means 
that some data is discarded during compression of the image. JPEG should not be used as 
an archive or production file format. You should generally only save JPEG files once, 
because re-saving continues to discard data and lower image quality. If you have acquired 
an image as a JPEG in your camera, be sure to save the edited document as a native Aurora 
HDR 2019 file. 

• PNG (.png) –  The Portable Network Graphics format provides lossless compression. It is 
increasingly common on the Internet, as most web browsers support it. The PNG format was 
created to be a patent-free alternative to GIF. Its major advantage is the PNG-24 file, which 
allows for 24-bit images (8 bits per channel) and embedded transparency. It is technically 
superior to GIF. 

• TIFF (.tif) – The Tagged-Image File Format is one of the most common and flexible formats 
available. It is widely used to exchange files between applications and computer platforms, 
and has a long legacy of compatibility.  Additionally, TIFF is one of the formats to work in a 
bit depth of 8 or 16 bits per channel.  

• JPEG-2000 (.jp2) – The JPEG-2000 format is an update released in the year 2000 from the 
Joint Photographic Experts Group committee.  Its intent was to replace the original JPEG 
format.  It uses a newer wavelet-based method of image compression which is more 
efficient. 

• Photoshop (.psd) – The Photoshop format is a common format used in the computer 
graphics industry.  Skylum cannot write a layered file, but can export a file that can be 
opened by Adobe Photoshop and other software packages which support the format. 

• PDF (.pdf) – The Portable Document Format (PDF) is a file format invented by Adobe and 
was intended to be an extension of PostScript. A PDF can be viewed on virtually every 
operating system and portable media player or phone. The PDF is an open standard, which 
means that the computer industry is able to create applications that can read or write PDFs 
without paying Adobe additional fees. This openness led to the quick adoption of PDF, and 
it is utilized online extensively. 

Aurora HDR 2019 User Guide Page !  of !94 103



Chapter 14 | Saving and Exporting Files

Open an Image in other Apps or Services 
If you’d like to send your image to another application or service, that’s easy too.  Aurora HDR 2019 
integrates with several other applications and web services to make sharing your finished photo (or  
work in-progress) fast and simple. Just click the Share Image… button at the top left corner of the 
application. Depending upon your platform, different options may be shown. 

• Mail – Attach a JPEG to a mail message. 

• Messages – Send a photo as a text or instant message. 

• Flickr – A photo sharing community with free and paid memberships 

• SmugMug – An online gallery community for selling prints 

• 500px – A photo sharing community with free and paid memberships 

• Open In – You can target any application which uses Aurora HDR 2019 as a plugin or 
extension. 

You may need to setup an account on these services to access them from within Aurora HDR 2019.  
If an application isn’t installed on your machine, it will be grayed out in the menu. 

Aurora HDR 2019 User Guide Page !  of !95 103

Im
ag

e 
by

 D
im

a 
Sy

tn
ik



Chapter 14 | Saving and Exporting Files

Open an Image in Other Applications 
Aurora HDR 2019 can easily exchange files with other applications.  Depending on your operating 
system and which applications you have installed, you may see different choices. 

• Luminar — The most powerful and easy-to-use photo editor 

• Aperture – Apple’s photo editing application for professionals 

• Photoshop – Adobe’s editor for editing images with layers 

• Elements – Photoshop Elements is an editing tool designed for consumers from Adobe. 

• Lightroom – A photo organizer and basic editor from Adobe 

• Photos – Photos for Mac is a photo organizer for Mac that also syncs with iOS. 
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Batch Processing Files 
Batch Processing is a powerful way to open, edit and save many images at once, saving time and 
effort. The tool is ideal for working on single images as well as many sets of bracketed exposures. 
Aurora HDR 2019 will automatically group brackets based on EXIF data stored in each image 
including exposure settings, aperture settings, ISO levels, lens data and time shot. 

Getting Started with Batch Processing 
To begin a Batch Processing session, either access it from the initial Open Aurora HDR 2019 dialog 
box, or… once the application has started, from File > Batch Processing… You can also access it by 
clicking the Open button in the top toolbar and choosing Batch Process. 

1. Load the Brackets. You can drag files or folders containing files into the new window to 
load them. You can also click the Browse button in the upper right corner to bring up the 
Open file dialog box. If the Include Subfolders option is on, and you’ve added folders, then 
Aurora HDR 2019 will search for all the images in every subfolder of the added folders.  Give 
the application a little time to analyze the images. 

2. Choose a develop method. Images can be processed as single images, or as HDR Brackets. 
To switch the image processing type, you have to press the appropriate button at the 
bottom in the middle of the window.  

• HDR Brackets mode is set by default, which will automatically sort and group exposure 
brackets and process them accordingly. 

•  If Single Images mode is selected, all the images will be treated as independent files and 
processed separately. 
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3. Drag any photos that are not properly grouped to the images you’d like to merge them with. 
4. If an image should not be processed, you can click the X in the upper left corner to remove 

it from the Batch window. 

5. If you want to remove a group of images from the Batch window, just click the Delete Group 
button. 

6. After the images you wish to process have been loaded and grouped, press the Continue 
button to reveal options and settings for Batch Processing. 
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Batch Processing Settings 
The Batch Processing feature is very versatile and contains many options that you can conveniently 
apply to a large set of images. Moving top to bottom, here are the options you have available:  

Default Settings 
• Aurora HDR Looks – The dropdown menu at the top lets you pick both the group and 

individual Aurora HDR Look to apply to your image. 
• Save to – This option lets you choose where processed files will be saved. You can save 

them in their current location or browse to select another folder. When you’ve made a 
choice, the file “path” will be displayed.  
Note: Because it is possible to overwrite your original files, it is good practice to save your 
batch-processed files in a new folder separate from the original files. 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• Naming – Aurora HDR 2019 has very flexible file naming options. You can add a prefix and 

suffix, choose from a variety of base names and even select the case of the letters. This gives 
you tremendous flexibility to organize your files as part of the batch processing operation. 

• Format – Choose the way types of files are created.   You can create JPEG, PNG, TIFF, PDF, 
JPEG-2000 or PSD files during batch processing. 

• Color Profile – This controls how the colors are interpreted.  Options include: sRGB, Adobe 
RGB, and ProPhoto RGB 

• Resize – Easily choose a dimension for the new files 

Advanced Settings 
If you need even more precise, be sure to try out the Advanced Settings.  Just click the Advanced 
button at the bottom of the Batch Settings window. 

• Sharpen – Enhances edge detail in the photos when merging 
• Color Denoise – Helps remove unwanted color noise in the image 
• HDR Settings – The options presented here mimic the HDR Merge dialog of the main 

Aurora HDR 2019 software. These include advanced options for alignment, ghost reduction, 
and chromatic aberration cleanup. Select the settings desired by clicking the appropriate 
checkboxes. 

Click Done to store the Advanced Settings. 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Running the Batch 
After selecting your desired Batch Processing options, click the Process button in the lower right of 
the window to begin the operation. This will display a processing window showing progress. 

• To return to the Image Selection window to select different images prior to beginning a 
Batch Processing operation, click the Back button in the lower left of the window.  

• To save your configuration for a future job, click the Save Settings button. 

• To cancel Batch Processing altogether, click the X in the upper-left corner of the window or 
click the Cancel button in the lower-right. 
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Keyboard Shortcuts 

General Shortcuts 
• F  — View the current image full-size on the screen. Return to the application by pressing any 

button. 

•  \  — Activates before/after comparison. When the key is pressed, the original image will be 
shown. The original image can be either the original tone-mapped result or a middle image 
in a bracket series. The last option is set by default. To change this option, simply go to the 
View > Compare With fly-out menu. Releasing the key will reveal the enhanced image. 

• ; — Activates a side-by-side comparison mode where the original image is on the left side 
and the edited result will be on the right side. To exit the mode press the ; button again. 

• Tab — Show/hide the Preset panel at the bottom of the window. 

• C — Enter the Crop tool 

• B — Activates the Brush Mask tool 

• G — Activates the Gradient Mask tool 

• R —  Activates the Radial Mask Tool 

• J — Show/hide the display of “hot” and “cold” pixels. These are completely black and white 
pixels on an image. 

• Cmd + B / Ctrl + B — Opens Batch Processing mode 

• Shift + Cmd + E  / Shift + Ctrl +E — - Export to a file 

• Shift + Cmd + F / Shift + Ctrl + F — Show current edited file in Finder/Explorer 

Mask Editing Shortcuts 
• [ — Decrease the brush radius 

• ] — Increases the brush radius 

• Shift + [ — Decreases the brush softness 

• Shift + ] — Increases the brush softness 

• X — Switches between Paint and Erase modes 

• Cmd + I / Ctrl + I — Inverts the layer mask 

• / —  Show current layer mask in the form of red transparent image imposition 

• Spacebar — Pans the image in the painting mode when zoomed in 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Keeping Aurora HDR 2019 Up to Date 
Aurora HDR 2019 has a handy automatic update feature to address updates, new features, 
enhancements and bug fixes. To ensure you’ve got the latest release, open the software and choose 
the Aurora HDR 2019 > Check for Updates (Mac) or Help > Check for Updates (PC). 
This will launch the Skylum update service and automatically grab any updates you need. Follow 
any prompts relating to installation and/or restarting the software. You may also need to input your 
Administrator Password and update the Plug-ins for your other applications. 

 

Thank you.  

If you have questions, contact Aurora HDR 24/7 support at support@skylum.com.  
You can also visit our support community forum at http://bit.ly/skylum_community.  
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